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Safety information

Conventions
Note: A note identifies information that could help you.

Warning: A warning identifies something that could damage the product hardware or software.

CAUTION: A caution indicates a potentially hazardous situation that could injure you.

Different types of caution statements include:

CAUTION—POTENTIAL INJURY:  Indicates a risk of injury.

CAUTION—SHOCK HAZARD: Indicates a risk of electrical shock.

CAUTION—HOT SURFACE: Indicates a risk of burn if touched.

CAUTION—TIPPING HAZARD: Indicates a crush hazard.

CAUTION—POTENTIAL INJURY: To avoid the risk of fire or electrical shock, connect the power cord to
an appropriately rated and properly grounded electrical outlet that is near the product and easily
accessible.

CAUTION—POTENTIAL INJURY: To avoid the risk of fire or electrical shock, use only the power cord
provided with this product or the manufacturer's authorized replacement.

CAUTION—POTENTIAL INJURY: Do not use this product with extension cords, multioutlet power strips,
multioutlet extenders, or UPS devices. The power capacity of these types of accessories can be easily
overloaded by a laser printer and may result in a risk of fire, property damage, or poor printer
performance.

CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock, do not place or use this product near
water or wet locations.

CAUTION—POTENTIAL INJURY: This product uses a laser. Use of controls or adjustments or
performance of procedures other than those specified in the User’s Guide may result in hazardous
radiation exposure.

This product uses a printing process that heats the print media, and the heat may cause the media to release
emissions. You must understand the section in your operating instructions that discusses the guidelines for
selecting print media to avoid the possibility of harmful emissions.

CAUTION—POTENTIAL INJURY:  The lithium battery in this product is not intended to be replaced.
There is a danger of explosion if a lithium battery is incorrectly replaced. Do not recharge, disassemble,
or incinerate a lithium battery. Discard used lithium batteries according to the manufacturer's instructions
and local regulations.

CAUTION—POTENTIAL INJURY:  Before moving the printer, follow these guidelines to avoid personal
injury or printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the electrical outlet.

• Disconnect all cords and cables from the printer before moving it.

• If an optional tray is installed, then remove it from the printer. To remove the optional tray, slide the latch on
the right side of the tray toward the front of the tray until it clicks into place.
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• Use the handholds located on both sides of the printer to lift it.

• Make sure your fingers are not under the printer when you set it down.

• Before setting up the printer, make sure there is adequate clearance around it.

Use only the power cord provided with this product or the manufacturer's authorized replacement.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching it.

CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware
or memory devices sometime after setting up the printer, then turn the printer off, and unplug the power
cord from the electrical outlet before continuing. If you have any other devices attached to the printer,
then turn them off as well, and unplug any cables going into the printer.

This product is designed, tested, and approved to meet strict global safety standards with the use of specific
manufacturer's components. The safety features of some parts may not always be obvious. The manufacturer
is not responsible for the use of other replacement parts.

CAUTION—POTENTIAL INJURY:  Do not cut, twist, bind, crush, or place heavy objects on the power
cords. Do not subject the power cords to abrasion or stress. Do not pinch the power cords between
objects such as the shelving system and any brackets. If any of these things happen, a risk of fire or
electrical shock results. Inspect the power cords regularly for signs of such problems. Remove the power
cords from the electrical outlet before inspecting them.

Refer service or repairs, other than those described in the user documentation, to a service representative.

CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior of the
printer, unplug the power cord from the electrical outlet and disconnect all cables from the printer before
proceeding.

CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately.
Keep all other trays closed until needed.

CAUTION—SHOCK HAZARD: Do not set up this product or make any electrical or cabling connections,
such as the fax feature, power cord, or telephone, during a lightning storm.

SAVE THESE INSTRUCTIONS.
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Learning about the printer

Finding information about the printer
What are you looking for? Find it here

Help to set up and use the printer:

• Accessing printer reports

• Accessing the Embedded Web Server

• Installing optional accessories

• Dell instructional videos

• Finding the service tag

• Routine printer maintenance

• Troubleshooting

Scan the Quick Response (QR) code to view product
documents.

Initial setup instructions:

• Connecting the printer

• Installing the printer software

Setup documentation—The setup documentation
came with the printer.

Additional setup and instructions for using the printer:

• Selecting and storing paper and specialty media

• Loading paper

• Configuring printer settings

• Viewing and printing documents and photos

• Setting up and using the printer software

• Configuring the printer on a network

• Caring for and maintaining the printer

• Troubleshooting and solving problems

User's Guide and Quick Reference Guide—The
guides are available on the Software CD.

For more information, go to
www.dell.com/support/manuals.

Help using the printer software Help for Microsoft® Windows® or Macintosh
operating systems—Open a printer software program
or application, and then click Help.

Click  to view context‑sensitive information.

Notes:

• Help is automatically installed with the printer
software.

• The printer software is located in the printer
program folder or on the desktop, depending
on your operating system.
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What are you looking for? Find it here

The latest supplemental information, updates, and technical
support:

• Documentation

• Driver downloads

• Product upgrades

• Service call and repair information

• Order status

• Live chat support

• E‑mail support

• Voice support

www.dell.com/support/printers

Notes:

• Support contact information for your country or
region is found on the support Web site.

• Documentation came with the printer and is
available on the Software CD.

Have the following information ready when you
contact technical support:

• Service tag

• Express service code

Note: The service tag and express service code
appear on labels on the printer.

• Software and Drivers—Certified drivers for your printer
and installers for Dell printer software

• Readme files—Last‑minute technical changes, or
advanced technical reference materials for experienced
users or technicians

Software CD

• Supplies and accessories for your printer

• Replacement cartridges

www.dell.com/printers

You can purchase printer supplies online, by
telephone, or in select retail stores.

• Safety information for preparing to operate your printer

• Regulatory information

• Warranty information

Product Information Guide

Notes:

• The Product Information Guide may not be
available in your country or region.

• Documentation came with the printer and is
available on the Software CD.

Selecting a location for the printer
When selecting a location for the printer, leave enough room to open trays, covers, and doors. If you plan to
install any hardware options, then leave enough room for them also. It is important to:

• Set up the printer near a properly grounded and easily accessible electrical outlet.

• Make sure airflow in the room meets the latest revision of the ASHRAE 62 standard or the CEN Technical
Committee 156 standard.

• Provide a flat, sturdy, and stable surface.
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• Keep the printer:

– Clean, dry, and free of dust.

– Away from stray staples and paper clips.

– Away from the direct airflow of air conditioners, heaters, or ventilators.

– Free from direct sunlight and humidity extremes.

• Observe the recommended temperatures and avoid fluctuations.

Ambient temperature 16 to 32°C (60 to 90°F)

Storage temperature ‑20 to 40°C (‑4 to 104°F)

• Allow the following recommended amount of space around the printer for proper ventilation:

1 Right side 110 mm (4.33 in.)

2 Front 305 mm (12 in.)

3 Left side 65 mm (2.56 in.)

4 Rear 100 mm (3.94 in.)

5 Top 305 mm (12 in.)

Printer configurations
CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately.
Keep all other trays closed until needed.

You can configure your printer by adding one optional 550‑sheet tray or two optional 250‑sheet trays. For more
information, see “Installing optional trays” on page 16.
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1 Printer control panel

2 Paper stop

3 Standard bin

4 Front door release button

5 Controller board access door

6 Standard 250‑sheet tray

7 Optional 250‑ or 550‑sheet tray

8 100‑sheet multipurpose feeder

9 Front door

Using the control panel
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Use the To

1 Display View the printer status and messages.

Set up and operate the printer.

2 Left arrow button Scroll to the left.

3 Select button  Select menu options.

Save settings.

4 Up arrow button Scroll up.

5 Right arrow button Scroll to the right.

6 Keypad Enter numbers, letters, or symbols.

7 Sleep button Enable Sleep mode or Hibernate mode.

The following actions wake the printer from Sleep mode:

• Pressing any hard button

• Sending a print job from the computer

• Performing a power‑on reset using the main power switch

The following actions wake the printer from Hibernate mode:

• Pressing the Sleep button until the printer wakes

• Performing a power‑on reset using the main power switch

8 Stop or cancel button Stop all printer activities.

9 Back button Return to the previous screen.

10 Down arrow button Scroll down.

11 Home button Go to the home screen.

12 Indicator light Check the status of the printer.

Understanding the status of the sleep button and
indicator light
Indicator light Printer status

Off The printer is off or in Hibernate mode.

Blinking green The printer is warming up, processing data, or printing.

Solid green The printer is on, but idle.

Blinking red The printer requires user intervention.

Sleep button light Printer status

Off The printer is off, idle or in Ready state.

Solid yellow The printer is in Sleep mode.

Blinking yellow The printer is entering or waking from Hibernate mode.
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Sleep button light Printer status

Blinking yellow for 0.1 second, then goes
completely off for 1.9 seconds in a slow,
pulsing pattern

The printer is in Hibernate mode.

Accessing the Embedded Web Server
The Embedded Web Server is the printer Web page that lets you view and remotely configure printer settings
even when you are not physically near the printer.

1 Obtain the printer IP address:

• From the printer control panel home screen

• From the TCP/IP section in the Network/Ports menu

• By printing a network setup page or menu settings page, and then finding the TCP/IP section

Note: An IP address appears as four sets of numbers separated by periods, such as 123.123.123.123.

2 Open a Web browser, and then type the printer IP address in the address field.

3 Press Enter.

Note: If you are using a proxy server, then temporarily disable it to load the Web page correctly.
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Additional printer setup

Installing internal options
CAUTION—SHOCK HAZARD:  If you are accessing the controller board or installing optional hardware
or memory devices sometime after setting up the printer, then turn the printer off, and unplug the power
cord from the electrical outlet before continuing. If you have any other devices attached to the printer,
then turn them off as well, and unplug any cables going into the printer.

Available internal options
• Flash memory

– Fonts

Accessing the controller board
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware
or memory devices sometime after setting up the printer, then turn the printer off, and unplug the power
cord from the electrical outlet before continuing. If you have any other devices attached to the printer,
then turn them off as well, and unplug any cables going into the printer.

1 Open the controller board access door.

2 Locate the memory card connector.

Warning—Potential Damage: Controller board electronic components are easily damaged by static
electricity. Touch a metal surface on the printer before touching any controller board electronic
components or connectors.
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Installing an optional card
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware
or memory devices sometime after setting up the printer, then turn the printer off, and unplug the power
cord from the electrical outlet before continuing. If you have any other devices attached to the printer,
then turn them off as well, and unplug any cables going into the printer.

Warning—Potential Damage: Controller board electronic components are easily damaged by static
electricity. Touch a metal surface on the printer before touching any controller board electronic components
or connectors.

1 Access the controller board.

For more information, see “Accessing the controller board” on page 13.

2 Unpack the optional card.

Warning—Potential Damage: Avoid touching the connection points along the edge of the card.
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3 Holding the card by its sides, align the plastic pins (1) on the card with the holes (2) on the controller board.

4 Push the card firmly into place as shown in the illustration.
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Warning—Potential Damage: Improper installation of the card may cause damage to the card and the
controller board.

Note: The entire length of the connector on the card must touch and be flush against the controller
board.

5 Close the controller board access door.

Note: When the printer software and any hardware options are installed, it may be necessary to manually
add the options in the printer driver to make them available for print jobs. For more information, see
“Adding available options in the print driver” on page 19.

Installing hardware options

Installing optional trays
CAUTION—SHOCK HAZARD: If you are accessing the controller board or installing optional hardware
or memory devices sometime after setting up the printer, then turn the printer off, and unplug the power
cord from the electrical outlet before continuing. If you have any other devices attached to the printer,
then turn them off as well, and unplug any cables going into the printer.

1 Turn off the printer using the power switch, and then unplug the power cord from the electrical outlet.

2 Unpack the tray, and then remove any packing material.

3 Remove the tray from the base.

4 Remove any packing material from inside the tray.

5 Insert the tray into the base.

6 Place the tray near the printer.
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7 Align the printer with the tray, and then slowly lower the printer into place.

8 Connect the power cord to the printer, then to a properly grounded electrical outlet, and then turn on the
printer.

Note: When the printer software and any hardware options are installed, it may be necessary to manually
add the options in the printer driver to make them available for print jobs. For more information, see
“Adding available options in the print driver” on page 19.

Attaching cables
Connect the printer to the computer using a USB or parallel cable, or to the network using an Ethernet cable.

Make sure to match the following:

• The USB symbol on the cable with the USB symbol on the printer

• The appropriate parallel cable with the parallel port

• The appropriate Ethernet cable with the Ethernet port
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Warning—Potential Damage: Do not touch the USB cable, any network adapter, or the printer in the area
shown while actively printing. Loss of data or a malfunction can occur.

Use the To

1 USB port Attach an optional wireless network adapter.

2 USB printer port Connect the printer to a computer.

3 Ethernet port Connect the printer to a network.

4 Parallel port Connect the printer to a computer.

5 Power switch Turn on or turn off the printer.

6 Printer power cord socket Connect the printer to an electrical outlet.

7 Security slot Attach a lock that will secure the printer in place.

Setting up the printer software

Installing the printer
1 Obtain a copy of the software installer package.

2 Run the installer, and then follow the instructions on the computer screen.

3 For Macintosh users, add the printer.

Note: Obtain the printer IP address from the TCP/IP section in the Network/Ports menu.
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Adding available options in the print driver

For Windows users

1 Open the printers folder.

2 Select the printer you want to update, and then do the following:

• For Windows 7 or later, select Printer properties.

• For earlier versions, select Properties.

3 Navigate to the Configuration tab, and then select Update Now ‑ Ask Printer.

4 Apply the changes.

For Macintosh users

1 From System Preferences in the Apple menu, navigate to your printer, and then select Options & Supplies.

2 Navigate to the list of hardware options, and then add any installed options.

3 Apply the changes.

Networking
Notes:

• Purchase a wireless network adapter before setting up the printer on a wireless network. To install the
wireless network adapter, see the instruction sheet that came with the adapter.

• A Service Set Identifier (SSID) is a name assigned to a wireless network. Wired Equivalent Privacy (WEP),
Wi-Fi Protected Access (WPA), WPA2, and 802.1X - RADIUS are types of security used on a network.

Preparing to set up the printer on an Ethernet network
To configure your printer to connect to an Ethernet network, organize the following information before you
begin:

Note: If your network automatically assigns IP addresses to computers and printers, continue on to installing
the printer.

• A valid, unique IP address for the printer to use on the network

• The network gateway

• The network mask

• A nickname for the printer (optional)

Note: A printer nickname can make it easier for you to identify your printer on the network. You can
choose to use the default printer nickname, or assign a name that is easier for you to remember.

You will need an Ethernet cable to connect the printer to the network and an available port where the printer
can physically connect to the network. Use a new network cable when possible to avoid potential problems
caused by a damaged cable.
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Preparing to set up the printer on a wireless network

Notes:

• Make sure your wireless network adapter is installed in your printer and working properly. For more
information, see the instruction sheet that came with the wireless network adapter.

• Make sure your access point (wireless router) is turned on and is working properly.

Make sure you have the following information before setting up the printer on a wireless network:

• SSID—The SSID is also referred to as the network name.

• Wireless Mode (or Network Mode)—The mode is either infrastructure or ad hoc.

• Channel (for ad hoc networks)—The channel defaults to automatic for infrastructure networks.

Some ad hoc networks will also require the automatic setting. Check with your system support person if
you are not sure which channel to select.

• Security Method—There are four basic options for Security Method:

– WEP key
If your network uses more than one WEP key, then enter up to four in the provided spaces. Select the
key currently in use on the network by selecting the default WEP transmit key.

– WPA or WPA2 preshared key or passphrase
WPA includes encryption as an additional layer of security. The choices are AES or TKIP. Encryption must
be set for the same type on the router and on the printer, or the printer will not be able to communicate
on the network.

– 802.1X–RADIUS

If you are installing the printer on an 802.1X network, then you may need the following:

• Authentication type

• Inner authentication type

• 802.1X user name and password

• Certificates

– No security
If your wireless network does not use any type of security, then you will not have any security information.

Note: We do not recommend using an unsecured wireless network.

Notes:

– If you do not know the SSID of the network that your computer is connected to, then launch the wireless
utility of the computer network adapter, and then look for the network name. If you cannot find the SSID
or the security information for your network, then see the documentation that came with the access
point, or contact your system support person.

– To find the WPA/WPA2 preshared key or passphrase for the wireless network, see the documentation
that came with the access point, see the Embedded Web Server associated with the access point, or
consult your system support person.
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Connecting the printer to a wireless network using Wi‑Fi Protected Setup
Before connecting the printer to a wireless network, make sure that:

• The access point (wireless router) is Wi‑Fi Protected Setup (WPS) certified or WPS‑compatible. For more
information, see the documentation that came with your access point.

• A wireless network adapter is installed on your printer and is working properly. For more information, see
the instruction sheet that came with the adapter.

Using the Push Button Configuration Method

1 From the control panel, navigate to:

 > Settings >  > Networks/Ports >  > Network [x] >  > Network [x] Setup >  > Wireless

>  > Wireless Connection Setup >  > Wi‑Fi Protected Setup >  > Start Push Button Method

> 

2 Follow the instructions on the printer display.

Using the Personal Identification Number (PIN) Method

1 From the control panel, navigate to:

 > Settings >  > Networks/Ports >  > Network [x] >  > Network [x] Setup >  > Wireless

>  > Wireless Connection Setup >  > Wi‑Fi Protected Setup >  > Start PIN Method > 

2 Copy the eight‑digit WPS PIN.

3 Open a Web browser, and then type the IP address of your access point in the address field.

Notes:

• The IP address appears as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are accessing a proxy server, then temporarily disable it to load the Web page correctly.

4 Access the WPS settings. For more information, see the documentation that came with your access
point.

5 Enter the eight‑digit PIN, and then save the setting.

Connecting the printer to a wireless network using the Embedded Web
Server
Before you begin, make sure that:

• Your printer is connected temporarily to an Ethernet network.

• A wireless network adapter is installed in your printer and working properly. For more information, see the
instruction sheet that came with your wireless network adapter.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address on the printer control panel. The IP address appears as four sets of
numbers separated by periods, such as 123.123.123.123.
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• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Network/Ports > Wireless.

3 Modify the settings to match the settings of your access point (wireless router).

Note: Make sure to enter the correct SSID.

4 Click Submit.

5 Turn off the printer, and then disconnect the Ethernet cable. Then wait for at least five seconds, and then
turn the printer back on.

6 To verify if your printer is connected to the network, print a network setup page. Then in the Network Card [x]
section, see if the status is Connected.

Verifying printer setup

Printing a menu settings page
Print a menu settings page to view the current menu settings and to verify if the printer options are installed
correctly.

From the printer control panel, navigate to:

 > Settings > Reports >  > Menu Settings Page > 

Note: If you have not changed any menu settings, then the menu settings page lists all the factory default
settings. Settings saved from the menus replace the factory default settings as user default settings. A user
default setting remains in effect until you access the menu again, select another value, and save it.

Printing a network setup page
If the printer is attached to a network, then print a network setup page to verify the network connection. This
page also provides important information that aids network printing configuration.

1 From the printer control panel, navigate to:

 > Settings > Reports >  > Network Setup Page > 

Note: If an optional internal print server is installed, then Print Network [x] Setup Page appears.

2 Check the first section of the network setup page, and confirm that the status is Connected.

If the status is Not Connected, then the LAN drop may not be active, or the network cable may be
malfunctioning. Consult your system support person for a solution, and then print another network setup
page.
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Loading paper and specialty media
The selection and handling of paper and specialty media can affect how reliably documents print. For more
information, see “Avoiding jams” on page 98 and “Paper and specialty media guide” on page 34.

Setting the paper size and type
1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Paper Size/Type > 

2 Press the up or down arrow button to select the tray or feeder, and then press .

3 Press the up or down arrow button to select the paper size, and then press .

4 Press the up or down arrow button to select the paper type, and then press  to change the settings.

Configuring Universal paper settings
The Universal paper size is a user‑defined setting that lets you print on paper sizes that are not preset in the
printer menus.

Notes:

• The smallest Universal paper size is 76 x 127 mm (3 x 5 inches), and is supported only from the
multipurpose feeder.

• The largest Universal paper size is 216 x 355.6 mm (8.5 x 14 inches), and is supported from all paper
sources.

1 From the control panel, navigate to:

 > Settings >  > Paper Menu >  > Universal Setup >  > Units of Measure >  > select a

unit of measure > 

2 Select Portrait Width or Portrait Height, and then press .

3 Press the left or right arrow button to change the setting, and then press .

Using the standard bin and paper stop
The standard bin holds up to 150 sheets of 75‑g/m2 (20‑lb) paper. It collects prints facedown. The standard bin
includes a paper stop that keeps paper from sliding out the front of the bin as it stacks.
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To open the paper stop, pull it so that it flips forward.

Note: Close the paper stop when moving the printer to another location.

Loading trays
CAUTION—POTENTIAL INJURY: To reduce the risk of equipment instability, load each tray separately.
Keep all other trays closed until needed.

1 Pull out the tray completely.

Note: Do not remove trays while a job prints or while Busy appears on the printer display. Doing so may
cause a jam.
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2 Squeeze and then slide the width guide tab to the correct position for the size of the paper you are loading.

3 Squeeze and then slide the length guide tab to the correct position for the size of the paper you are loading.

Notes:

• For some paper sizes like letter, legal, and A4, squeeze and slide the length guide tab backward to
accommodate their length.

• If you are loading A6-size paper in the standard tray, then squeeze and then slide the length guide
tab toward the center of the tray to the A6‑size position.

• Make sure the width and length guides are aligned with the paper size indicators on the bottom of
the tray.
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4 Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten
the edges on a level surface.

5 Load the paper stack.

Notes:

• Load with the printable side facedown when using recycled or preprinted paper.

• Load prepunched paper with the holes on the top edge toward the front of the tray.
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• Load letterhead facedown, with the top edge of the sheet toward the front of the tray. For two‑sided
printing, load letterhead faceup with the bottom edge of the sheet toward the front of the tray.

• Make sure the paper is below the maximum paper fill indicator located on the side of the width guide.

6 Insert the tray.

7 From the printer control panel, set the paper size and paper type in the Paper menu to match the paper
loaded in the tray.

Note: Set the correct paper size and type to avoid paper jams and print quality problems.
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Loading the multipurpose feeder
Use the multipurpose feeder when printing on different paper sizes and types or specialty media, such as card
stock, transparencies, and envelopes. You can also use it for single‑page print jobs on letterhead.

1 Open the multipurpose feeder.

a Pull the multipurpose feeder extender.

b Pull the extender gently so that the multipurpose feeder is fully extended and open.
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2 Squeeze the tab on the left width guide, and then move the guides for the paper you are loading.

3 Prepare the paper or specialty media for loading.

• Flex sheets of paper back and forth to loosen them, and then fan them. Do not fold or crease the paper.
Straighten the edges on a level surface.

• Hold transparencies by the edges. Flex the stack of transparencies back and forth to loosen them, and
then fan them. Straighten the edges on a level surface.

Note: Avoid touching the printable side of the transparencies. Be careful not to scratch them.

• Flex the stack of envelopes back and forth to loosen them, and then fan them. Straighten the edges on
a level surface.

4 Load the paper or specialty media.
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Notes:

• Do not force paper or specialty media into the multipurpose feeder.

• Make sure the paper or specialty media is below the maximum paper fill indicator located on the
paper guides. Overfilling may cause paper jams.

• Load paper, transparencies, and card stock with the recommended printable side faceup and the top
edge entering the printer first. For more information on loading transparencies, see the packaging that
the transparencies came in.

Note: When loading A6‑size paper, make sure the multipurpose feeder extender rests lightly against
the edge of the paper so that the last few sheets of paper remain in place.

Loading paper and specialty media 30



• Load letterhead faceup with the top edge entering the printer first. For two‑sided (duplex) printing, load
letterhead facedown with the bottom edge entering the printer first.

• Load envelopes with the flap on the left side facedown.

Warning—Potential Damage: Never use envelopes with stamps, clasps, snaps, windows, coated
linings, or self‑stick adhesives. These envelopes may severely damage the printer.

5 From the printer control panel, set the paper size and paper type in the Paper menu to match the paper or
specialty media loaded in the multipurpose feeder.
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Linking and unlinking trays

Linking and unlinking trays
1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address on the control panel in the TCP/IP section under the Network/Ports menu.
The IP address appears as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu.

3 Change the paper size and type settings for the trays you are linking.

• To link trays, make sure the paper size and type for the tray match that of the other tray.

• To unlink trays, make sure the paper size or type for the tray does not match that of the other tray.

4 Click Submit.

Note: You can also change the paper size and type settings using the control panel. For more information,
see “Setting the paper size and type” on page 23.

Warning—Potential Damage: Paper loaded in the tray should match the paper type name assigned in the
printer. The temperature of the fuser varies according to the specified paper type. Printing issues may occur
if settings are not properly configured.

Assigning a custom paper type

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears
as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Paper Menu > Custom Types.

3 Select a custom paper type name, and then select a paper type.

Note: Paper is the factory default paper type for all user‑defined custom names.

4 Click Submit.

Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Paper Menu >  > Custom Types

2 Select a custom paper type name, and then select a paper type.

Note: Paper is the factory default paper type for all user‑defined custom names.
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3 Press .
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Paper and specialty media guide

Paper guidelines
Selecting the correct paper or specialty media reduces printing problems. For the best print quality, try a sample
of the paper or specialty media before buying large quantities.

Paper characteristics
The following paper characteristics affect print quality and reliability. Consider these characteristics when
evaluating new paper stock.

Weight

The printer trays can automatically feed paper weights up to 90‑g/m2 (24‑lb) bond grain long paper. The
multipurpose feeder can automatically feed paper weights up to 163‑g/m2 (43‑lb) bond grain long paper. Paper
lighter than 60 g/m2 (16 lb) might not be stiff enough to feed properly, causing jams. For best performance, use
75‑g/m2 (20‑lb) bond grain long paper. For paper smaller than 182 x 257 mm (7.2 x 10.1 inches), we recommended
to use 90 g/m2 (24 lb) or heavier paper.

Note: Two‑sided printing is supported only for 60–90‑g/m2 (16–24‑lb) bond paper.

Curl

Curl is the tendency for paper to curl at its edges. Excessive curl can cause paper feeding problems. Curl can
occur after the paper passes through the printer, where it is exposed to high temperatures. Storing paper
unwrapped in hot, humid, cold, or dry conditions, even in the trays, can contribute to paper curling prior to
printing and can cause feeding problems.

Smoothness

Paper smoothness directly affects print quality. If paper is too rough, then toner cannot fuse to it properly. If
paper is too smooth, then it can cause paper feeding or print quality issues. Always use paper between 100
and 300 Sheffield points; however, smoothness between 150 and 250 Sheffield points produces the best print
quality.

Moisture content

The amount of moisture in paper affects both print quality and the ability of the printer to feed the paper correctly.
Leave paper in its original wrapper until it is time to use it. This limits the exposure of paper to moisture changes
that can degrade its performance.

Store paper in its original wrapper in the same environment as the printer for 24 to 48 hours before printing.
Extend the time to several days if the storage or transportation environment is very different from the printer
environment. Thick paper may also require a longer conditioning period.

Grain direction

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length
of the paper, or grain short, running the width of the paper.

For 60–90‑g/m2 (16–24‑lb) bond paper, grain long paper is recommended.
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Fiber content

Most high‑quality xerographic paper is made from 100% chemically treated pulped wood. This content provides
the paper with a high degree of stability resulting in fewer paper feeding problems and better print quality.
Paper containing fibers such as cotton can negatively affect paper handling.

Unacceptable paper
The following paper types are not recommended for use with the printer:

• Chemically treated papers used to make copies without carbon paper, also known as carbonless papers,
carbonless copy paper (CCP), or no carbon required (NCR) paper

• Preprinted papers with chemicals that may contaminate the printer

• Preprinted papers that can be affected by the temperature in the printer fuser

• Preprinted papers that require a registration (the precise print location on the page) less than ±2.5 mm
(±0.10 inch), such as optical character recognition (OCR) forms

In some cases, registration can be adjusted with a software application to successfully print on these forms:

• Coated papers (erasable bond), synthetic papers, thermal papers

• Rough‑edged, rough or heavily textured surface papers, or curled papers

• Recycled papers that fail EN12281:2002 (European)

• Paper weighing less than 60 g/m2 (16 lb)

• Multiple‑part forms or documents

Selecting paper
Using the appropriate paper prevents jams and helps ensure trouble‑free printing.

To help avoid paper jams and poor print quality:

• Always use new, undamaged paper.

• Before loading paper, know the recommended printable side of the paper. This information is usually
indicated on the paper package.

• Do not use paper that has been cut or trimmed by hand.

• Do not mix paper sizes, types, or weights in the same tray; mixing results in jams.

• Do not use coated papers unless they are specifically designed for electrophotographic printing.

Selecting preprinted forms and letterhead
Use these guidelines when selecting preprinted forms and letterhead:

• Use grain long for 60 to 90 g/m2 (16 to 24 lb) weight paper.

• Use only forms and letterhead printed using an offset lithographic or engraved printing process.

• Avoid papers with rough or heavily textured surfaces.

Use papers printed with heat‑resistant inks designed for use in xerographic copiers. The ink must be able to
withstand temperatures up to 230°C (446°F) without melting or releasing hazardous emissions. Use inks that
are not affected by the resin in toner. Inks that are oxidation‑set or oil‑based generally meet these requirements;
latex inks might not. When in doubt, contact the paper supplier.
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Preprinted papers such as letterhead must be able to withstand temperatures up to 230°C (446°F) without
melting or releasing hazardous emissions.

Using recycled paper and other office papers
Recycled office paper produced specifically for use in laser (electrophotographic) printers may be used in your
printer. However, no blanket statement can be made that all recycled paper will feed well.

Generally, the following property guidelines apply to recycled paper.

• Amount of post-consumer waste (We test up to 100% post-consumer waste content.)

• Temperature and humidity conditions (Testing chambers simulate climates from all over the world.)

• Moisture content (Business papers should have low moisture: 4–5%.)

• Bending resistance and proper stiffness means optimum feeding through the printer.

• Thickness (impacts how much can be loaded into a tray)

• Surface roughness (measured in Sheffield units, impacts print clarity and how well toner fuses to the paper)

• Surface friction (determines how easily sheets can be separated)

• Grain and formation (impacts curling, which also influences the mechanics of how the paper behaves as it
moves through the printer)

• Brightness and texture (look and feel)

Recycled papers are better than ever; however, the amount of recycled content in a paper affects the degree
of control over foreign matter. And while recycled papers are one good path to printing in an environmentally
responsible manner, they are not perfect. The energy required to de-ink and deal with additives such as
colorants and “glue” often generates more carbon emissions than does normal paper production. However,
using recycled papers enables better resource management overall.

Unacceptable paper examples

Test results indicate that the following paper types are at risk for use with laser printers:

• Chemically treated papers used to make copies without carbon paper, also known as carbonless papers

• Preprinted papers with chemicals that may contaminate the printer

• Preprinted papers that can be affected by the temperature in the printer fuser

• Preprinted papers that require a registration (the precise location on the page) greater than ± 2.3 mm (±
0.9 in.), such as optical character recognition (OCR) forms. In some cases, registration can be adjusted with
a software application to successfully print on these forms.)

• Coated papers (erasable bond), synthetic papers, thermal papers

• Rough-edged, rough or heavily textured surface papers or curled papers

• Recycled papers that fail EN12281:2002 (European testing)

• Paper weighing less than 60 g/m2 (16 lb)

• Multiple part forms or documents
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Using specialty media

Tips on using card stock
Card stock is heavy, single‑ply specialty media. Many of its variable characteristics, such as moisture content,
thickness, and texture, can significantly impact print quality. Print samples on the card stock being considered
for use before buying large quantities.

When printing on card stock:

• Make sure the Paper Type is Card Stock.

• Select the appropriate Paper Texture setting.

• Be aware that preprinting, perforation, and creasing may significantly affect the print quality and cause jams
or other paper handling problems.

• Check with the manufacturer or vendor to ensure that the card stock can withstand temperatures up to
240°C (464°F) without releasing hazardous emissions.

• Do not use preprinted card stock manufactured with chemicals that may contaminate the printer. Preprinting
introduces semi‑liquid and volatile components into the printer.

• Use grain short card stock when possible.

Tips on using envelopes
Print samples on the envelopes being considered for use before buying large quantities.

• Use envelopes designed specifically for laser printers. Check with the manufacturer or vendor to ensure
that the envelopes can withstand temperatures up to 230°C (446°F) without sealing, wrinkling, curling
excessively, or releasing hazardous emissions.

• For best performance, use envelopes made from 90‑g/m2 (24‑lb bond) paper or 25% cotton. All‑cotton
envelopes must not exceed 70‑g/m2 (20‑lb bond) weight.

• Use only new envelopes from undamaged packages.

• To optimize performance and minimize jams, do not use envelopes that:

– Have excessive curl or twist

– Are stuck together or damaged in any way

– Have windows, holes, perforations, cutouts, or embossing

– Have metal clasps, string ties, or folding bars

– Have an interlocking design

– Have postage stamps attached

– Have any exposed adhesive when the flap is in the sealed or closed position

– Have bent corners

– Have rough, cockle, or laid finishes

• Adjust the width guides to fit the width of the envelopes.

Note: A combination of high humidity (over 60%) and high printing temperature may wrinkle or seal
envelopes.
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Tips on using labels
Print samples on the labels being considered for use before buying large quantities.

Note: Use only paper label sheets. Vinyl, pharmacy, and two‑sided labels are not supported.

When printing on labels:

• Use labels designed specifically for laser printers. Check with the manufacturer or vendor to verify that:

– The labels can withstand temperatures up to 240°C (464°F) without sealing, excessive curling, wrinkling,
or releasing hazardous emissions.

– Label adhesives, face sheet (printable stock), and topcoats can withstand up to 172‑kPa (25‑psi) pressure
without delaminating, oozing around the edges, or releasing hazardous fumes.

• Do not use labels with slick backing material.

• Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial
sheets also contaminate the printer and the cartridge with adhesive, and could void the printer and toner
cartridge warranties.

• Do not use labels with exposed adhesive.

• Do not print within 1 mm (0.04 inch) of the edge of the label, of the perforations, or between die‑cuts of the
label.

• Make sure the adhesive backing does not reach to the edge of the sheet. Zone coating of the adhesive
should be at least 1 mm (0.04 inch) away from edges. Adhesive material contaminates the printer and could
void the warranty.

• If zone coating of the adhesive is not possible, then remove a 2‑mm (0.08‑inch) strip on the leading and
driver edge, and then use a non‑oozing adhesive.

• Portrait orientation is recommended, especially when printing bar codes.

Tips on using letterhead
• Use letterhead designed specifically for laser printers.

• Print samples on the letterhead being considered for use before buying large quantities.

• Before loading letterhead, flex, fan, and straighten the stack to prevent sheets from sticking together.

• Page orientation is important when printing on letterhead. For information on how to load letterhead, see:

– “Loading trays” on page 24

– “Loading the multipurpose feeder” on page 28

Tips on using transparencies
• Print a test page on the transparencies being considered for use before buying large quantities.

• Feed transparencies from the standard tray, or the multipurpose feeder.

• Use transparencies designed specifically for laser printers. Transparencies must be able to withstand
temperatures up to 185°C (365°F) without melting, discoloring, offsetting, or releasing hazardous emissions.

Note: If the transparency weight is set to Heavy and the transparency texture is set to Rough in the Paper
menu, then transparencies can be printed at a temperature up to 195°C (383°F).

• Avoid getting fingerprints on the transparencies to prevent print quality problems.

• Before loading transparencies, flex, fan, and straighten the stack to prevent sheets from sticking together.
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Storing paper
Use these paper storage guidelines to help avoid jams and uneven print quality:

• For best results, store paper where the temperature is 21°C (70°F) and the relative humidity is 40 percent.
Most label manufacturers recommend printing in a temperature range of 18–24°C (65–75°F) with relative
humidity between 40 and 60 percent.

• Store paper in cartons, on a pallet or shelf, rather than on the floor.

• Store individual packages on a flat surface.

• Do not store anything on top of individual paper packages.

• Take paper out of the carton or wrapper only when you are ready to load it in the printer. The carton and
wrapper help keep the paper clean, dry, and flat.

Supported paper sizes, types, and weights

Supported paper sizes
Paper size Standard tray Optional 250‑ or

550‑sheet tray
Multipurpose feeder Duplex mode

A4

210 x 297 mm (8.3 x 11.7 in.)

A5

148 x 210 mm (5.8 x 8.3 in.)

X

A6

105 x 148 mm (4.1 x 5.8 in.)

X X

JIS B5

182 x 257 mm (7.2 x 10.1 in.)

X

Letter

216 x 279 mm (8.5 x 11 in.)

Legal

216 x 356 mm (8.5 x 14 in.)

Executive

184 x 267 mm (7.3 x 10.5 in.)

X

Oficio (Mexico)

216 x 340 mm (8.5 x 13.4 in.)

1 This size setting formats the page for 216 x 356 mm (8.5 x 14 in.) unless the size is specified by the software
application.
2 Universal is supported in the standard tray only if the paper size is at least 105 x 148 mm (4.1 x 5.8 in.). Universal
is supported in the optional 250- or 550-sheet tray only if the paper size is at least 148 x 210 mm (5.8 x 8.3 in.).
Universal is supported in duplex mode only if the width is at least 210 mm (8.3 in.) and the length is at least 279 mm
(11 in.). The smallest supported Universal size is supported only in the multipurpose feeder.
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Paper size Standard tray Optional 250‑ or
550‑sheet tray

Multipurpose feeder Duplex mode

Folio

216 x 330 mm (8.5 x 13 in.)

Statement

140 x 216 mm (5.5 x 8.5 in.)

X

Universal1, 2

76.2 x 127 mm (3 x 5 in.) up to
216 x 356 mm (8.5 x 14 in.)

7 3/4 Envelope (Monarch)

98 x 191 mm (3.9 x 7.5 in.)

X X X

9 Envelope

98 x 225 mm (3.9 x 8.9 in.)

X X X

10 Envelope

105 x 241 mm (4.1 x 9.5 in.)

X X X

DL Envelope

110 x 220 mm (4.3 x 8.7 in.)

X X X

C5 Envelope

162 x 229 mm (6.4 x 9 in.)

X X X

B5 Envelope

176 x 250 mm (6.9 x 9.8 in.)

X X X

Other Envelope

229 x 356 mm (9 x 14 in.)

X X X

1 This size setting formats the page for 216 x 356 mm (8.5 x 14 in.) unless the size is specified by the software
application.
2 Universal is supported in the standard tray only if the paper size is at least 105 x 148 mm (4.1 x 5.8 in.). Universal
is supported in the optional 250- or 550-sheet tray only if the paper size is at least 148 x 210 mm (5.8 x 8.3 in.).
Universal is supported in duplex mode only if the width is at least 210 mm (8.3 in.) and the length is at least 279 mm
(11 in.). The smallest supported Universal size is supported only in the multipurpose feeder.

Supported paper types and weights

Notes:

• The standard tray supports 60–90‑g/m2 (16–24‑lb) paper weights.

• The optional tray supports 60–120‑g/m2 (16–32‑lb) paper weights.

• The multipurpose feeder supports 60–163‑g/m2 (16–43‑lb) paper weights.

Paper type 250‑ or 550‑sheet tray Multipurpose feeder Duplex mode

Plain paper

Card stock X X
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Paper type 250‑ or 550‑sheet tray Multipurpose feeder Duplex mode

Transparencies X

Recycled X

Glossy paper X X X

Paper labels1

Vinyl labels X X X

Bond2

Envelope X X

Rough envelope X X

Letterhead

Preprinted

Colored Paper

Light Paper

Heavy Paper2

Rough/Cotton X

Custom Type [x]

1 One‑sided paper labels designed for laser printers are supported for occasional use. Print only 20 or fewer pages
of paper labels per month. Vinyl, pharmacy, and two‑sided labels are not supported.
2 Bond and Heavy Paper are supported in duplex mode up to 90‑g/m2 (24‑lb) paper weight.
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Printing

Printing a document

Printing from a computer
Note: For specialty media such as labels, card stock, and envelopes, set the paper size and type in the
printer before sending the print job.

1 With a document open, click File > Print.

2 If necessary, adjust the settings.

3 Send the print job.

Printing held jobs
1 With a document open, select File > Print.

2 Select the printer, and then do the following:

• For Windows users, click Properties or Preferences, and then click Print and Hold.

• For Macintosh users, select Print and Hold.

3 Select the print job type.

4 If necessary, assign a user name.

5 Send the print job.

6 From the printer home screen, select Held Jobs.

Note: The Change Options setting is not available for the Held Jobs function.

7 Send the print job.

Adjusting toner darkness

Using the Embedded Web Server

1 Open a Web browser, and then type the IP address of the printer in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears
as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Print Settings > Quality Menu > Toner Darkness.

3 Adjust the toner darkness, and then click Submit.
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Using the printer control panel

1 From the printer control panel, navigate to:

 > Settings >  > Print Settings >  > Quality Menu >  > Toner Darkness

2 Adjust the toner darkness, and then press .

Printing from a mobile device
Note: Make sure that the printer and mobile device share the same wireless network. For information on
configuring the wireless settings of your mobile device, see the documentation that came with the device.

Printing from a mobile device using Mopria Print Service
Mopria® Print Service is a mobile printing solution for mobile devices running on Android version 4.4 or later. It
allows you to print directly to any Mopria‑certified printer.

Note: Before printing, make sure that the Mopria Print Service is enabled.

1 From the home screen of your mobile device, launch a compatible application.

2 Tap Print, and then select the printer.

3 Send the print job.

Printing from a mobile device using Google Cloud Print
Google Cloud PrintTM is a mobile printing service that allows enabled applications on mobile devices to print
to any Google Cloud Print‑ready printer.

1 From the home screen of your mobile device, launch an enabled application.

2 Tap Print, and then select the printer.

3 Send the print job.

Printing from a mobile device using AirPrint
AirPrintTM is a mobile printing solution that allows you to print directly from Apple devices to an AirPrint‑certified
printer.

Note: This application is supported only in some Apple devices.

1 From the home screen of your mobile device, launch a compatible application.

2 Select an item to print, and then tap the share icon.

3 Tap Print, and then select the printer.

4 Send the print job.
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Printing from a mobile device using Dell Document Hub
1 From Google Play, download the Dell Document Hub application.

2 From the home screen of your mobile device, tap .

3 Select the item to print.

4 Tap Print.

Printing information pages

Printing a font sample list
1 From the printer control panel, navigate to:

 > Settings >  > Reports >  > Print Fonts

2 Press the up or down arrow button to select the font setting.

3 Press .

Note: The PPDS fonts appear only when the PPDS data stream is activated.

Printing a directory list
From the control panel, navigate to:

 > Settings > Reports >  > Print Directory > 

Note: The Print Directory menu item appears only when an optional flash memory card is installed.

Canceling a print job

Canceling a print job from the printer control panel

From the printer control panel, press  > .

Canceling a print job from the computer
1 Depending on the operating system, do either of the following:

• Open the printers folder, and then select your printer.

• From the System Preferences in the Apple menu, navigate to your printer.

2 Select the print job to cancel.
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Understanding the printer menus

Menus list
Paper Menu Reports Network/Ports

Default Source

Paper Size/Type

Configure MP

Substitute Size

Paper Texture

Paper Weight

Paper Loading

Custom Types

Universal Setup

Menu Settings Page

Device Statistics

Network Setup Page1

Print Fonts

Print Directory

Print Demo

Asset Report

Event Log Summary

Active NIC

Standard Network2

Standard USB

Standard Parallel

SMTP Setup

Security Settings Help

Confidential Print

Security Audit Log

Set Date and Time

General Settings

Print Settings

Print All Guides

Print Quality

Printing Guide

Media Guide

Print Defects Guide

Menu Map

Information Guide

Connection Guide

Moving Guide

Supplies Guide

1 Depending on the printer setup, this menu item appears as Network Setup Page or Network [x] Setup Page.
2 Depending on the printer setup, this menu item appears as Standard Network or Network [x].

Paper menu

Default Source menu
Use To

Default Source
Tray [x]
Multipurpose Feeder
Manual Paper
Manual Envelope

Set a default paper source for all print jobs.

Notes:

• Tray 1 (standard tray) is the factory default setting.

• From the Paper menu, set Configure MP to Cassette for
Multipurpose Feeder to appear as a menu setting.
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Paper Size/Type menu
Use To

Tray [x] Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal

Specify the paper size loaded in each tray.

Notes:

• Letter is the U.S. factory default setting. A4 is the international
factory default setting.

• The A6 paper size is supported only in Tray 1 and in the
multipurpose feeder.

Tray [x] Type
Plain Paper
Transparency
Recycled
Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the type of paper loaded in each tray.

Notes:

• Plain Paper is the factory default setting for Tray 1. Custom Type [x]
is the factory default setting for all other trays.

• If available, a user‑defined name appears instead of Custom Type
[x].

• Use this menu to configure automatic tray linking.

Note: Only installed trays and feeders are listed in this menu.
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Use To

Multipurpose Feeder Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
C5 Envelope
B5 Envelope
Other Envelope

Specify the paper size loaded in the multipurpose feeder.

Notes:

• Letter is the U.S. factory default setting. A4 is the international
factory default setting.

• From the Paper menu, set Configure MP to Cassette for
Multipurpose Feeder Size to appear as a menu.

• The multipurpose feeder does not automatically detect paper size.
Make sure to set the paper size value.

Multipurpose Feeder Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Bond
Envelope
Rough Envelope
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify paper type loaded in the multipurpose feeder.

Notes:

• Plain Paper is the factory default setting.

• From the Paper menu, set Configure MP to Cassette for
Multipurpose Feeder Type to appear as a menu.

Note: Only installed trays and feeders are listed in this menu.
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Use To

Manual Paper Size
A4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio (Mexico)
Folio
Statement
Universal

Specify the paper size being manually loaded.

Note: Letter is the U.S. factory default setting. A4 is the international
factory default setting.

Manual Paper Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton
Custom Type [x]

Specify the paper type being manually loaded.

Notes:

• Plain Paper is the factory default setting.

• From the Paper menu, set Configure MP to Manual for Manual
Paper Type to appear as a menu.

Manual Envelope Size
7 3/4 Envelope
9 Envelope
10 Envelope
DL Envelope
C5 Envelope
B5 Envelope
Other Envelope

Specify the envelope size being manually loaded.

Note: 10 Envelope is the U.S. factory default setting. DL Envelope is the
international factory default setting.

Manual Envelope Type
Envelope
Rough Envelope
Custom Type [x]

Specify the envelope type being manually loaded.

Note: Envelope is the factory default setting.

Note: Only installed trays and feeders are listed in this menu.
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Configure MP menu
Use To

Configure MP
Cassette
Manual
First

Determine when the printer selects paper from the multipurpose feeder.

Notes:

• Cassette is the factory default setting. Cassette configures the
multipurpose feeder as the default paper source.

• Manual sets the multipurpose feeder only for manual‑feed print jobs.

• First sets the multipurpose feeder as the primary paper source
regardless of settings.

Substitute Size menu
Use To

Substitute Size
Off
Statement/A5
Letter/A4
All Listed

Substitute a specified paper size if the requested paper size is not
available.

Notes:

• All Listed is the factory default setting. All available substitutions are
allowed.

• Off indicates that no size substitutions are allowed.

• Setting a size substitution lets the print job continue without Change
Paper appearing.

Paper Texture menu
Use To

Plain Texture
Smooth
Normal
Rough

Specify the relative texture of the plain paper loaded.

Note: Normal is the factory default setting.

Card Stock Texture
Smooth
Normal
Rough

Specify the relative texture of the card stock loaded.

Notes:

• Normal is the factory default setting.

• The options appear only if card stock is supported.

Transparency Texture
Smooth
Normal
Rough

Specify the relative texture of the transparencies loaded.

Note: Normal is the factory default setting.

Recycled Texture
Smooth
Normal
Rough

Specify the relative texture of the recycled paper loaded.

Note: Normal is the factory default setting.
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Use To

Labels Texture
Smooth
Normal
Rough

Specify the relative texture of the labels loaded.

Note: Normal is the factory default setting.

Bond Texture
Smooth
Normal
Rough

Specify the relative texture of the bond paper loaded.

Note: Rough is the factory default setting.

Envelope Texture
Smooth
Normal
Rough

Specify the relative texture of the envelopes loaded.

Note: Normal is the factory default setting.

Rough Envelope Texture
Rough

Specify the relative texture of the rough envelopes loaded.

Letterhead Texture
Smooth
Normal
Rough

Specify the relative texture of the letterhead loaded.

Note: Normal is the factory default setting.

Preprinted Texture
Smooth
Normal
Rough

Specify the relative texture of the preprinted paper loaded.

Note: Normal is the factory default setting.

Colored Texture
Smooth
Normal
Rough

Specify the relative texture of the colored paper loaded.

Note: Normal is the factory default setting.

Light Texture
Smooth
Normal
Rough

Specify the relative texture of the paper loaded.

Note: Normal is the factory default setting.

Heavy Texture
Smooth
Normal
Rough

Specify the relative texture of the paper loaded.

Note: Normal is the factory default setting.

Rough/Cotton Texture
Rough

Specify the relative texture of the cotton paper loaded.

Custom [x] Texture
Smooth
Normal
Rough

Specify the relative texture of the custom paper loaded.

Notes:

• Normal is the factory default setting.

• The options appear only if the custom type is supported.
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Paper Weight menu
Use To

Plain Weight
Light
Normal
Heavy

Specify the relative weight of the plain paper loaded.

Note: Normal is the factory default setting.

Card Stock Weight
Light
Normal
Heavy

Specify the relative weight of the card stock loaded.

Note: Normal is the factory default setting.

Transparency Weight
Light
Normal
Heavy

Specify the relative weight of the transparencies loaded.

Note: Normal is the factory default setting.

Recycled Weight
Light
Normal
Heavy

Specify the relative weight of the recycled paper loaded.

Note: Normal is the factory default setting.

Labels Weight
Light
Normal
Heavy

Specify the relative weight of the labels loaded.

Note: Normal is the factory default setting.

Bond Weight
Light
Normal
Heavy

Specify the relative weight of the bond paper loaded.

Note: Normal is the factory default setting.

Envelope Weight
Light
Normal
Heavy

Specify the relative weight of the envelope loaded.

Note: Normal is the factory default setting.

Rough Envelope Weight
Light
Normal
Heavy

Specify the relative weight of the rough envelope loaded.

Note: Normal is the factory default setting.

Letterhead Weight
Light
Normal
Heavy

Specify the relative weight of the letterhead loaded.

Note: Normal is the factory default setting.

Preprinted Weight
Light
Normal
Heavy

Specify the relative weight of the preprinted paper loaded.

Note: Normal is the factory default setting.
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Use To

Colored Weight
Light
Normal
Heavy

Specify the relative weight of the colored paper loaded.

Note: Normal is the factory default setting.

Light Weight
Light

Specify that the weight of the paper loaded is light.

Heavy Weight
Heavy

Specify that the weight of the paper loaded is heavy.

Rough/Cotton Weight
Light
Normal
Heavy

Specify the relative weight of the cotton or rough paper loaded.

Note: Heavy is the factory default setting.

Custom [x] Weight
Light
Normal
Heavy

Specify the relative weight of the custom paper loaded.

Notes:

• Normal is the factory default setting.

• The options appear only when the custom type is supported.

Paper Loading menu
Use To

Recycled Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Recycled as the paper type.

Bond Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Bond as the paper type.

Letterhead Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Letterhead as the paper type.

Preprinted Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Preprinted as the paper type.

Colored Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Colored as the paper type.

Notes:

• Duplex sets two‑sided printing as the default for all print jobs unless one‑sided printing is set from Printing
Preferences or Print dialog.

• If Duplex is selected, then all print jobs are sent through the duplex unit, including one‑sided jobs.

• Off is the factory default setting for all the menus.
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Use To

Light Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Light as the paper type.

Heavy Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Heavy as the paper type.

Custom [x] Loading
Duplex
Off

Determine and set two‑sided printing for all print jobs that specify
Custom [x] as the paper type.

Note: Custom [x] Loading is available only if the custom type is
supported.

Notes:

• Duplex sets two‑sided printing as the default for all print jobs unless one‑sided printing is set from Printing
Preferences or Print dialog.

• If Duplex is selected, then all print jobs are sent through the duplex unit, including one‑sided jobs.

• Off is the factory default setting for all the menus.

Custom Types menu
Use To

Custom Type [x]
Paper
Card Stock
Transparency
Rough/Cotton
Labels
Envelope

Associate a paper or specialty media type with a factory default custom
type name or a user‑defined custom name created from the Embedded
Web Server.

Notes:

• Paper is the factory default setting.

• The custom media type must be supported by the selected tray or
multipurpose feeder in order to print from that source.

Recycled
Paper
Card Stock
Transparency
Rough/Cotton
Labels
Envelope

Specify a paper type when Recycled is selected in other menus.

Notes:

• Paper is the factory default setting.

• The custom media type must be supported by the selected tray or
multipurpose feeder in order to print from that source.

Universal Setup menu
Use To

Units of Measure
Inches
Millimeters

Identify the units of measure.

Notes:

• Inches is the US factory default setting.

• Millimeters is the international factory default setting.
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Use To

Portrait Width
3–8.5 inches
76–216 mm

Set the portrait width.

Notes:

• If the width exceeds the maximum, then the printer uses the
maximum width allowed.

• 8.5 inches is the US factory default setting. You can increase
the width in 0.01‑inch increments.

• 216 mm is the international factory default setting. You can
increase the width in 1‑mm increments.

Portrait Height
3–14.17 inches
76–360 mm

Set the portrait height.

Notes:

• If the height exceeds the maximum, then the printer uses the
maximum height allowed.

• 14 inches is the US factory default setting. You can increase the
height in 0.01‑inch increments.

• 356 mm is the international factory default setting. You can
increase the height in 1‑mm increments.

Feed Direction
Short Edge
Long Edge

Specify the feed direction if the paper can be loaded in either
direction.

Notes:

• Short Edge is the factory default setting.

• Long Edge appears only when the longest edge is shorter than
the maximum width supported in the tray.

Reports menu

Reports menu
Use To

Menu Settings Page Print a report containing information about the paper loaded in trays,
installed memory, total page count, alarms, timeouts, control panel
language, TCP/IP address, status of supplies, status of the network
connection, and other information.

Device Statistics Print a report containing printer statistics, such as supply information and
details about printed pages.

Network Setup Page Print a report containing information about the network printer settings, such
as the TCP/IP address information.

Note: This menu item appears only in network printers or in printers
connected to print servers.

Profiles List Print a list of profiles stored in the printer.

Note: This menu item appears only when LDSS is enabled.
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Use To

Print Fonts
PCL Fonts
PostScript Fonts

Print a report of all the fonts available for the printer language currently set
in the printer.

Note: A separate list is available for PCL and PostScript emulations.

Print Directory Print a list of all the resources stored in an optional flash memory card.

Notes:

• Job Buffer Size must be set to 100%.

• Make sure the optional flash memory card is installed correctly and
working properly.

• This menu item appears only when an optional flash memory card is
installed.

Asset Report Print a report containing printer asset information, such as serial number
and model name.

Event Log Summary Print a report containing a summary of all logged events.

Network/Ports menu
The menus in this section only appear in network printers or printers connected to print servers.

Active NIC menu
Use To

Active NIC
Auto
[list of available network cards]

Notes:

• Auto is the factory default setting.

• This menu item appears only when an optional network card is installed.

Standard Network or Network [x] menus
Note: Only active ports appear in this menu.

Use To

Energy Efficient Ethernet
Enable
Disable

Set the printer Ethernet connection to a energy‑saving mode.

Note: Enable is the factory default setting.

PCL SmartSwitch
On
Off

Set the printer to automatically switch to PCL emulation when a print job
requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When Off is used, the printer does not examine incoming data. The
printer uses PostScript emulation if PS SmartSwitch is set to On. It uses
the default printer language specified in the Setup menu if PS
SmartSwitch is set to Off.
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Use To

PS SmartSwitch
On
Off

Set the printer to automatically switch to PS emulation when a print job requires
it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When Off is used, the printer does not examine incoming data. The
printer uses PCL emulation if PCL SmartSwitch is set to On. It uses the
default printer language specified in the Setup menu if PCL SmartSwitch
is set to Off.

NPA Mode
Off
Auto

Set the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol.

Notes:

• Auto is the factory default setting.

• Changing this setting from the control panel, and then exiting the menus
causes the printer to restart. The menu selection is then updated.

Network Buffer
Auto
3KB to [maximum size allowed]

Set the size of the network input buffer.

Notes:

• Auto is the factory default setting.

• The value can be changed in 1‑KB increments.

• The maximum size allowed depends on the amount of memory in the
printer, the size of the other link buffers, and whether Resource Save is
set to On or Off.

• To increase the maximum size range for the Network Buffer, disable or
reduce the size of the parallel, serial, and USB buffers.

• Changing this setting from the control panel and then exiting the menus
causes the printer to restart. The menu selection is then updated.

Mac Binary PS
On
Off
Auto

Set the printer to process Macintosh binary PostScript print jobs.

Notes:

• Auto is the factory default setting.

• Off filters print jobs using the standard protocol.

• On processes raw binary PostScript print jobs.

Standard Network Setup OR
Network [x] Setup

Reports
Network Card
TCP/IP
IPv6
Wireless
AppleTalk

Display and set the printer network settings.

Note: The Wireless menu appears only when the printer is connected to a
wireless network.
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Reports menu
Use To

Print Setup Page Print a report containing information about the network printer settings, such as the TCP/IP
address.

Network Card menu
Use To

View Card Status
Connected
Disconnected

View the connection status of the network card.

View Card Speed View the speed of an active network card.

Network Address
UAA
LAA

View the network addresses.

Job Timeout

0–255 seconds

Set the amount of time it takes for a network print job to be canceled.

Notes:

• 90 seconds is the factory default setting.

• A setting value of 0 disables the timeout.

• If a value of 1–9 is selected, then the setting is saved as 10.

Banner Page
Off
On

Enable banner pages.

Note: Off is the factory default setting

TCP/IP menu
Note: This menu is available only in network printers or printers connected to print servers.

Use To

Set Hostname Set the host name.

Notes:

• This setting can be changed only from the Embedded Web Server.

• The host name can be up to 15 characters and can be a US‑ASCII or
alphanumeric character, or hyphen.

IP Address View or change the current TCP/IP address.

Note: Manually setting the IP address sets the Enable DHCP and Enable Auto
IP settings to Off. It also sets Enable BOOTP and Enable RARP to Off on
systems that support BOOTP and RARP.

Netmask View or change the current TCP/IP netmask.

Gateway View or change the current TCP/IP gateway.
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Use To

Enable DHCP
On
Off

Specify the DHCP address and parameter assignment.

Note: On is the factory default setting.

Enable AutoIP
Yes
No

Specify the Zero Configuration Networking setting.

Note: Yes is the factory default setting.

Enable FTP/TFTP
Yes
No

Enable the built-in FTP server, which lets you send files to the printer using File
Transfer Protocol.

Note: Yes is the factory default setting.

Enable HTTP Server
Yes
No

Enable the built-in Web server (Embedded Web Server). When enabled, the
printer can be monitored and managed remotely using a Web browser.

Note: Yes is the factory default setting.

WINS Server Address View or change the current WINS server address.

Enable DDNS
Yes
No

View or change the current DDNS setting.

Note: Yes is the factory default setting.

Enable mDNS
Yes
No

View or change the current mDNS setting.

Note: Yes is the factory default setting.

DNS Server Address View or change the current DNS server address.

Backup DNS Server Address View or change the backup DNS server addresses.

Backup DNS Server Address 2

Backup DNS Server Address 3

Enable HTTPS
Yes
No

View or change the current HTTPS setting.

Note: Yes is the factory default setting.

IPv6 menu
To access the menu, navigate to any of the following:

• Network/Ports > Standard Network > Standard Network Setup > IPv6

• Network/Ports > Network [x] > Network [x] Setup > IPv6

Note: This menu is available only in network printers or printers connected to print servers.

Use To

Enable IPv6
On
Off

Enable Internet Protocol Version Six (IPv6) in the printer.

IPv6 uses bigger numbers to create IP addresses.

Note: On is the factory default setting.

* These settings can be changed only from the Embedded Web Server.
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Use To

Auto Configuration
On
Off

Specify whether or not the network adapter accepts the automatic
IPv6 address configuration entries provided by a router.

Note: On is the factory default setting.

Set Hostname* Set the host name.

Note: The host name is limited to 15 characters, and accepts
US‑ASCII, alphanumeric characters and hyphen only.

View Address* View the current IPv6 addresses.

View Router Address* View the current router address.

Enable DHCPv6
On
Off

Enable DHCPv6 in the printer.

Note: On is the factory default setting.

* These settings can be changed only from the Embedded Web Server.

Wireless menu
Note: This menu is available only in printer models connected to a wireless network.

Use To

Wi‑Fi Protected Setup (WPS)
Start Push Button Method
Start PIN Method

Establish a wireless network and enable network security.

Notes:

• Start Push Button Method connects the printer to a wireless
network by pressing buttons on both the printer and the
access point (wireless router) within a given period of time.

• Start PIN Method connects the printer to a wireless network by
using a PIN on the printer and entering it into the wireless
settings of the access point.

Enable/Disable WPS Auto‑detection
Enable
Disable

Automatically detect the connection method that an access point
with WPS uses—Start Push Button Method or Start PIN Method.

Note: Disable is the factory default setting.

Network Mode
Infrastructure
Ad hoc

Specify the network mode.

Notes:

• Ad hoc is the factory default setting. This configures wireless
connection directly between the printer and a computer.

• Infrastructure lets the printer access a network using an access
point.

Compatibility
802.11b/g
802.11 b/g/n

Specify the wireless standard for the wireless network.

Note: The 802.11b/g/n is the factory default setting.

Choose Network Select an available network for the printer to use.

View Signal Quality View the quality of the wireless connection.

View Security Mode View the encryption method for the wireless network.
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AppleTalk menu
To access the menu, navigate to either of the following:

• Network/Ports > Standard Network > Standard Network Setup > AppleTalk

• Network/Ports > Network [x] > Network [x] Setup > AppleTalk

Use To

Activate
Yes
No

Enable or disable AppleTalk support.

Note: No is the factory default setting.

View Name Show the assigned AppleTalk name.

Note: The AppleTalk name can be changed only from the Embedded
Web Server.

View Address Show the assigned AppleTalk address.

Note: The AppleTalk address can be changed only from the Embedded
Web Server.

Set Zone
[list of zones available on the
network]

Provide a list of AppleTalk zones available on the network.

Note: The default zone for the network is the factory default setting.

Standard USB menu
Use To

PCL SmartSwitch
On
Off

Set the printer to automatically switch to PCL emulation when a print job
received through a USB port requires it, regardless of the default printer
language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer
uses PostScript emulation if the PS SmartSwitch is set to On. It uses the
default printer language specified in the Setup menu if the PS
SmartSwitch is set to Off.

PS SmartSwitch
On
Off

Set the printer to automatically switch to PS emulation when a print job received
through a USB port requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer
uses PCL emulation if the PCL SmartSwitch is set to On. It uses the
default printer language specified in the Setup menu if the PCL
SmartSwitch is set to Off.
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Use To

NPA Mode
On
Off
Auto

Set the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol.

Notes:

• Auto is the factory default setting. Auto sets the printer to examine data,
determine the format, and then process it appropriately.

• The printer automatically restarts when changing the setting from the
printer control panel. The menu selection is then updated.

USB Buffer
Disabled
Auto
3K to [maximum size allowed]

Set the size of the USB input buffer.

Notes:

• Auto is the factory default setting.

• Disabled turns off job buffering.

• The USB buffer size value can be changed in 1-KB increments.

• The maximum size allowed depends on the amount of memory in the
printer, the size of the other link buffers, and whether Resource Save is
set to On or Off.

• To increase the maximum size range for USB Buffer, disable or reduce
the size of the parallel, serial, and network buffers.

• The printer automatically restarts when the setting is changed from the
printer control panel. The menu selection is then updated.

Mac Binary PS
On
Off
Auto

Set the printer to process Macintosh binary PostScript print jobs.

Notes:

• Auto is the factory default setting.

• On processes raw binary PostScript print jobs.

• Off filters print jobs using the standard protocol.

ENA Address
yyy.yyy.yyy.yyy

Set the network address information for an external print server.

Note: This menu is available only when the printer is attached to an external
print server through the USB port.

ENA Netmask
yyy.yyy.yyy.yyy

Set the netmask information for an external print server.

Note: This menu is available only when the printer is attached to an external
print server through the USB port.

ENA Gateway
yyy.yyy.yyy.yyy

Set the gateway information for an external print server.

Note: This menu is available only when the printer is attached to an external
print server through the USB port.
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Standard Parallel menu
Use To

PCL SmartSwitch
On
Off

Set the printer to automatically switch to PCL emulation when a print job
received through a serial port requires it, regardless of the default printer
language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer
uses PostScript emulation if PS SmartSwitch is set to On. It uses the
default printer language specified in the Setup menu if PS SmartSwitch is
set to Off.

PS SmartSwitch
On
Off

Set the printer to automatically switch to PS emulation when a print job received
through a serial port requires it, regardless of the default printer language.

Notes:

• On is the factory default setting.

• When set to Off, the printer does not examine incoming data. The printer
uses PCL emulation if PCL SmartSwitch is set to On. It uses the default
printer language specified in the Setup menu if PCL SmartSwitch is set to
Off.

NPA Mode
On
Off
Auto

Set the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol.

Notes:

• Auto is the factory default setting.

• Changing this setting from the control panel and then exiting the menus
causes the printer to restart. The menu selection is then updated.

Parallel Buffer
Disabled
Auto
3K to [maximum size allowed]

Set the size of the parallel input buffer.

Notes:

• Auto is the factory default setting.

• Disabled turns off job buffering. Any print jobs already buffered on the
printer hard disk are printed before normal processing resumes.

• The parallel buffer size setting can be changed in 1‑KB increments.

• The maximum size allowed depends on the amount of memory in the
printer, the size of the other link buffers, and whether Resource Save is
set to On or Off.

• To increase the maximum size range for the Parallel Buffer, disable or
reduce the size of the USB, serial, and network buffers.

• Changing this setting from the control panel and then exiting the menus
causes the printer to restart. The menu selection is then updated.

Advanced Status
On
Off

Enable bidirectional communication through the parallel port.

Notes:

• On is the factory default setting.

• Off disables parallel port negotiation.
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Use To

Protocol
Standard
Fastbytes

Specify the parallel port protocol.

Notes:

• Fastbytes is the factory default setting. It provides compatibility with most
existing parallel ports and is the recommended setting.

• Standard tries to resolve parallel port communication problems.

Honor Init
On
Off

Determine if the printer honors printer hardware initialization requests from the
computer.

Notes:

• Off is the factory default setting.

• The computer requests initialization by activating the Init signal from the
parallel port. Many personal computers activate the Init signal each time
the computer is turned on.

Parallel Mode 2
On
Off

Determine if the parallel port data is sampled on the leading or trailing edge of
a strobe.

Note: On is the factory default setting.

Mac Binary PS
On
Off
Auto

Set the printer to process Macintosh binary PostScript print jobs.

Notes:

• Auto is the factory default setting.

• Off filters print jobs using the standard protocol.

• On processes raw binary PostScript print jobs.

ENA Address
yyy.yyy.yyy.yyy

Set the network address information for an external print server.

Note: This menu item is available only if the printer is attached to an external
print server through the USB port.

ENA Netmask
yyy.yyy.yyy.yyy

Set the netmask information for an external print server.

Note: This menu item is available only if the printer is attached to an external
print server through the USB port.

ENA Gateway
yyy.yyy.yyy.yyy

Set the gateway information for an external print server.

Note: This menu item is available only if the printer is attached to an external
print server through the USB port.

SMTP Setup menu
Use To

Primary SMTP Gateway Specify SMTP server gateway and port information.

Note: 25 is the default SMTP gateway port.Primary SMTP Gateway Port

Secondary SMTP Gateway

Secondary SMTP Gateway Port
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Use To

SMTP Timeout
5–30

Specify the amount of time in seconds before the server stops trying
to send an e‑mail.

Note: 30 seconds is the factory default setting.

Reply Address Specify a reply address of up to 128 characters in the e-mail sent by
the printer.

Use SSL
Disabled
Negotiate
Required

Set the printer to use SSL for increased security when connecting to
the SMTP server.

Notes:

• Disabled is the factory default setting.

• When the Negotiate setting is used, the SMTP server
determines if SSL will be used.

SMTP Server Authentication
No authentication required
Login/Plain
CRAM‑MD5
Digest‑MD5
NTLM
Kerberos 5

Specify the type of user authentication required for printing
privileges.

Note: “No authentication required” is the factory default setting.

Device‑Initiated E‑mail
None
Use Device SMTP Credentials

Specify what credentials will be used when communicating to the
SMTP server. Some SMTP servers require credentials to send an e-
mail.

Notes:

• None is the factory default setting for Device‑Initiated E‑mail.

• Device Userid and Device Password are used to log in to the
SMTP server when Use Device SMTP Credentials is selected.

Device Userid

Device Password

Security menu

Confidential Print menu
Use To

Max Invalid PIN
Off
2–10

Limit the number of times an invalid PIN can be entered.

Note: Once the limit is reached, the print jobs for that user name and PIN are
deleted.

Note: Off is the factory default setting.
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Use To

Confidential Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Limit the amount of time a confidential print job stays in the printer before it is deleted.

Notes:

• If the Confidential Job Expiration setting is changed while confidential print jobs
reside in the printer RAM, then the expiration time for those print jobs does not
change to the new default value.

• If the printer is turned off, then all confidential jobs held in the printer RAM are
deleted.

Repeat Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a time limit on how long the printer stores print jobs.

Verify Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a time limit on how long the printer stores print jobs needing verification.

Reserve Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Set a time limit on how long the printer stores print jobs for printing at a later time.

Note: Off is the factory default setting.

Security Audit Log menu
Use To

Delete Log
Delete now
Do not delete

Specify whether or not audit logs are deleted.

Note: Delete now is the factory default setting.
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Use To

Configure Log
Enable Audit

Yes
No

Enable Remote Syslog
No
Yes

Remote Syslog Facility
0–23

Severity of events to log
0–7

Specify how and whether or not audit logs are created.

Notes:

• Enable Audit determines if events are recorded in the secure audit log
and remote syslog. No is the factory default setting.

• Enable Remote Syslog determines if logs are sent to a remote server. No
is the factory default setting.

• Remote Syslog Facility determines the value used to send logs to the
remote syslog server. 4 is the factory default setting.

• If the security audit log is activated, then the severity value of each event
is recorded. 4 is the factory default setting.

Set Date and Time menu
Use To

Current Date and Time View the current date and time settings for the printer.

Note: The date and time are set in YYYY‑MM‑DD HH:MM format.

Manually Set Date and Time
[input date/time]

Enter the date and time.

Note: Setting the date and time using this menu automatically sets Enable
NTP to Off.

Time Zone
[list of time zones]

Select the time zone.

Note: GMT is the factory default setting.

Automatically observe DST
On
Off

Set the printer to use the applicable daylight saving time (DST) start and end
times associated with the printer Time Zone setting.

Note: On is the factory default setting.

Enable NTP
On
Off

Enable Network Time Protocol, which synchronizes the clocks of devices on a
network.

Notes:

• On is the factory default setting.

• Enable NTP is automatically set to Off if you manually set the date and
time.

Understanding the printer menus 66



Settings menu

General Settings menu
Use To

Display Language
English
Francais
Deutsch
Italiano
Espanol
Dansk
Norsk
Nederlands
Svenska
Portuguese
Suomi
Russian
Polski
Greek
Magyar
Turkce
Cesky
Simplified Chinese
Traditional Chinese
Korean
Japanese

Set the language of the text appearing on the display.

Show Supply Estimates
Show estimates
Do not show estimates

View the status of supplies.

Eco-Mode
Off
Energy
Energy/Paper
Paper

Minimize the use of energy, paper, or specialty media.

Note: Off is the factory default setting.

Quiet Mode
Off
On

Minimize the printer noise.

Note: Off is the factory default setting.

Run Initial setup
Yes
No

Run the setup wizard.
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Paper Sizes
US
Metric

Specify the unit of measurement for paper sizes.

Notes:

• US is the factory default setting.

• The country or region you selected during the initial
setup determines the initial setting.

Home screen customization
Change Language
Search Held Jobs
Held Jobs

Change the icons that appear on the home screen.

Note: Do not display is the factory default setting.

Timeouts
Sleep Mode

Disabled
1–120

Set the amount of time in minutes that the printer waits before
it goes into a reduced power state after printing.

Notes:

• 20 is the factory default setting.

• Disabled appears only when Energy Conserve is set to
Off.

• The maximum amount of time is increased to 240
minutes when Energy Conserve is set to Off.

• Lower settings conserve more energy, but may require
longer warm‑up times.

• If the printer is in constant use, then select a high setting
to keep the printer ready to print with minimum warm‑up
time.

Timeouts
Print with Display Off

Allow printing with display off
Display on when printing

Print a job with the display turned off.

Note: Display on when printing is the factory default setting.

Timeouts
Hibernate Timeout

Disabled
20 minutes
1‑3 hours
6 hours
1‑3 days
1‑2 weeks
1 month

Set the amount of time that the printer waits before it enters
Hibernate mode.

Note: 3 days is the factory default setting.

Timeouts
Hibernate Timeout on Connection

Hibernate
Do Not Hibernate

Set the printer to Hibernate mode even if there is an active
Ethernet connection.

Note: Do Not Hibernate is the factory default setting.

Timeouts
Screen Timeout

15–300

Set the amount of time in seconds before returning the control
panel to a Ready state.

Note: 30 is the factory default setting.
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Timeouts
Print Timeout

Disabled
1–255

Set the amount of time in seconds that the printer waits to
receive an end‑of‑job message before canceling the job.

Notes:

• 90 is the factory default setting.

• When the timer expires, a partially printed page that is
still in the printer is printed.

• Print Timeout is available only when using PCL
emulation. This setting has no effect on PostScript
emulation print jobs.

Timeouts
Wait Timeout

Disabled
15–65535

Set the amount of time in seconds that the printer waits for
additional data before it cancels a print job.

Notes:

• 40 is the factory default setting.

• Wait Timeout is available only when the printer is using
PostScript emulation. This setting has no effect on PCL
emulation print jobs.

Error Recovery
Auto Reboot

Reboot when idle
Reboot always
Reboot never

Max Auto Reboots
1–20

Set the printer to restart when an error occurs.

Notes:

• Reboot always is the factory default setting for Auto
Reboot.

• 2 is the factory default setting for Max Auto Reboots.

• When the same error occurred after a set of automatic
reboots, the printer no longer restarts and shows the
error instead.

Print Recovery
Auto Continue

Disabled
5–255 sec

Let the printer automatically continue printing from certain
offline situations.

Note: Disabled is the factory default setting.

Print Recovery
Jam Recovery

On
Off
Auto

Specify whether the printer reprints jammed pages.

Note: Auto is the factory default setting. The printer reprints
jammed pages unless the memory required to hold the
pages is needed for other printer tasks.

Print Recovery
Jam Assist

On
Off

Set the printer to check automatically for jammed paper.

Note: On is the factory default setting.
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Print Recovery
Page Protect

Off
On

Successfully print a page that may not have printed otherwise.

Notes:

• Off is the factory default setting. This setting allows
printing of a partial page when there is not enough
memory to print the whole page.

• On sets the printer to print the entire page.

Press Sleep Button
Do nothing
Sleep
Hibernate

Determine how the printer, while in idle state, reacts to a short
press of the Sleep button.

Note: Sleep is the factory default setting.

Press and Hold Sleep Button
Do nothing
Sleep
Hibernate

Determine how the printer, while in idle state, reacts to a long
press of the Sleep button.

Note: Do nothing is the factory default setting.

Factory Defaults
Do Not Restore
Restore Now

Use the printer factory default settings.

Note: Do Not Restore is the factory default setting.

Custom Home Message
Off
IP Address
Hostname
Contact Name
Location
Zero Configuration Name
Custom Text [x]

Select a custom home message that appears as an alternating
display of the printer status.

Note: Off is the factory default setting.

Print Settings

Setup menu

Use To

Printer Language
PCL Emulation
PS Emulation

Set the default printer language.

Notes:

• PCL Emulation is the factory default setting.

• PostScript emulation uses a PostScript interpreter for
processing print jobs.

• PCL Emulation uses a PCL interpreter for processing
print jobs.

• Setting a printer language default does not prevent a
software program from sending print jobs that use
another printer language.
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Print Area
Normal
Whole Page

Set the logical and physical printable area.

Notes:

• Normal is the factory default setting. When attempting to
print data on the non‑printable area defined by the
Normal setting, the printer clips the image at the
boundary.

• Whole Page allows the image to be moved into the
non‑printable area defined by the Normal setting. This
setting affects only pages printed using a PCL 5
interpreter and has no effect on pages printed using the
PCL XL or PostScript interpreter.

Download Target
RAM
Flash

Set the storage location for downloads.

Notes:

• RAM is the factory default setting. Storing downloads in
the RAM is temporary.

• Storing downloads in a flash memory places them in
permanent storage. Downloads remain in the flash
memory even when the printer is turned off.

• This menu item appears only when an optional flash
memory is installed.

Resource Save
On
Off

Specify how the printer handles temporary downloads, such
as fonts and macros stored in the RAM, when the printer
receives a print job that requires more than the available
memory.

Notes:

• Off is the factory default setting. Off sets the printer to
retain downloads only until memory is needed.
Downloads are deleted in order to process print jobs.

• On sets the printer to retain downloads during language
changes and printer resets. If the printer runs out of
memory, then Memory Full [38] appears on the
printer display, but downloads are not deleted.

Understanding the printer menus 71



Finishing menu

Use To

Sides (Duplex)
1 sided
2 sided

Specify whether two‑sided (duplex) printing is set as the default for all print jobs.

Notes:

• “1 sided” is the factory default setting.

• You can set two‑sided printing from the software program.

For Windows users:

1 Click File > Print.

2 Click Properties, Preferences, Options, or Setup.

For Macintosh users:

1 Choose File > Print.

2 Adjust the settings from the print dialog and pop‑up menus.

Duplex Binding
Long Edge
Short Edge

Define the way two‑sided pages are bound and printed.

Notes:

• Long Edge is the factory default setting. Long Edge binds pages along
their long edge (left edge for portrait and top edge for landscape).

• Short Edge binds pages along their short edge (top edge for portrait and
left edge for landscape).

Copies
1–999

Specify the default number of copies for each print job.

Note: 1 is the factory default setting.

Blank Pages
Do Not Print
Print

Specify whether to insert blank pages in a print job.

Note: Do Not Print is the factory default setting.

Collate
(1,1,1) (2,2,2)
(1,2,3) (1,2,3)

Stack the pages of a print job in sequence when printing multiple copies.

Note: “(1,2,3) (1,2,3)” is the factory default setting.

Separator Sheets
Off
Between Copies
Between Jobs
Between Pages

Specify whether to insert blank separator sheets.

Notes:

• Off is the factory default setting.

• Between Copies inserts a blank sheet between each copy of a print job if
Collate is set to (1,1,1) (2,2,2). If Collate is set to (1,2,3) (1,2,3), then a blank
page is inserted between each set of printed pages, such as after all
page 2's and after all page 3's.

• Between Jobs inserts a blank sheet between print jobs.

• Between Pages inserts a blank sheet between each page of a print job.
This setting is useful when printing transparencies or when inserting
blank pages in a document.

Separator Source
Tray [x]
Multi‑Purpose Feeder

Specify the paper source for separator sheets.

Note: Tray 1 (standard tray) is the factory default setting.
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Paper Saver
Off
2‑Up
3‑Up
4‑Up
6‑Up
9‑Up
12‑Up
16‑Up

Print multiple‑page images on one side of a paper.

Notes:

• Off is the factory default setting.

• The number selected is the number of page images that will print per
side.

Paper Saver Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specify the positioning of multiple‑page images when using Paper Saver.

Notes:

• Horizontal is the factory default setting.

• Positioning depends on the number of page images and whether they
are in portrait or landscape orientation.

Paper Saver Orientation
Auto
Landscape
Portrait

Specify the orientation of a multiple‑page document.

Note: Auto is the factory default setting. The printer chooses between
portrait and landscape.

Paper Saver Border
None
Solid

Print a border when using Paper Saver.

Note: None is the factory default setting.

Quality menu

Use To

Print Resolution
300 dpi
600 dpi
1200 dpi
1200 Image Q
2400 Image Q

Specify the printed output resolution in dots per inch.

Note: 600 dpi is the factory default setting.

Pixel Boost
Off
Fonts
Horizontally
Vertically
Both directions

Enable more pixels to print in clusters for clarity, in order to enhance images
horizontally or vertically, or to enhance fonts.

Note: Off is the factory default setting.

Toner Darkness
1–10

Lighten or darken the printed output.

Notes:

• 8 is the factory default setting.

• Selecting a smaller number can help conserve toner.
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Enhance Fine Lines
On
Off

Enable a print mode preferable for files such as architectural drawings, maps,
electrical circuit diagrams, and flow charts.

Notes:

• Off is the factory default setting.

• You can set this option from the printer software. For Windows users, click
File > Print, and then click Properties, Preferences, Options, or Setup. For
Macintosh users, choose File > Print, and then adjust the settings from the
Print dialog and context menus.

• To set this option using the Embedded Web Server, type the network printer
IP address in the Web browser address field.

Gray Correction
Auto
Off

Automatically adjust the contrast enhancement applied to images.

Note: Auto is the factory default setting.

Brightness
‑6 to 6

Adjust the printed output either by lightening or darkening it. You can conserve
toner by lightening the output.

Note: 0 is the factory default setting.

Contrast
0–5

Adjust the contrast of printed objects.

Note: 0 is the factory default setting.

XPS menu

Use To

Print Error Pages
Off
On

Print a page containing information on errors, including XML markup errors.

Note: Off is the factory default setting.

PostScript menu

Use To

Print PS Error
On
Off

Print a page containing the PostScript error.

Note: Off is the factory default setting.

Lock PS Startup Mode
On
Off

Disable the SysStart file.

Note: Off is the factory default setting.
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Font Priority
Resident
Flash

Establish the font search order.

Notes:

• Resident is the factory default setting.

• This menu item is available only when a formatted flash memory card
is installed and operating properly.

• Make sure the flash memory card is not read/write‑, write‑, or
password‑protected.

• Job Buffer Size must not be set to 100%.

Job Accounting menu

Note: This menu item appears only when an optional flash memory card is installed.

Use To

Job Accounting Log
Off
On

Determine and set if the printer creates a log of the print jobs it receives.

Note: Off is the factory default setting.

Job Accounting Utilities Print and delete log files or export them to a flash drive.

Accounting Log Frequency
Daily
Weekly
Monthly

Determine and set how often a log file is created.

Note: Monthly is the factory default setting.

Log Action at End of Frequency
None
E‑mail Current Log
E‑mail & Delete Current Log
Post Current Log
Post & Delete Current Log

Determine and set how the printer responds when the frequency threshold
expires.

Note: None is the factory default setting.

Log Near Full Level
Off
1–49 for optional flash memory
cards

Specify the maximum size of the log file before the printer executes the Log
Action at Near Full.

Note: 5 is the factory default setting.
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Log Action at Near Full
None
E‑mail Current Log
E‑mail & Delete Current Log
E‑mail & Delete Oldest Log
Post Current Log
Post & Delete Current Log
Post & Delete Oldest Log
Delete Current Log
Delete Oldest Log
Delete All Logs
Delete All But Current

Determine and set how the printer responds when the flash memory is nearly
full.

Notes:

• None is the factory default setting.

• The value defined in Log Near Full Level determines when this action is
triggered.

Log Action at Full
None
E‑mail & Delete Current Log
E‑mail & Delete Oldest Log
Post & Delete Current Log
Post & Delete Oldest Log
Delete Current Log
Delete Oldest Log
Delete All Logs
Delete All But Current

Determine and set how the printer responds when flash memory usage reaches
the maximum limit (100MB).

Note: None is the factory default setting.

URL to Post Logs Determine and set where the printer posts job accounting logs.

E‑mail Address to Send Logs Specify the e‑mail address to which the device sends job accounting logs.

Log File Prefix Specify the prefix you want for the log file name.

Note: The current host name defined in the TCP/IP menu is used as the
default log file prefix.

PDF menu

Use To

Scale to Fit
Yes
No

Scale page content to fit the selected paper size.

Note: No is the factory default setting.

Annotations
Do Not Print
Print

Print annotations in a PDF.

Note: Do Not Print is the factory default setting.
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PCL Emul menu

Use To

Font Source
Resident
Download
Flash
All

Specify the set of fonts used by the Font Name menu.

Notes:

• Resident is the factory default setting. This shows the factory default
set of fonts downloaded in the RAM.

• Download shows all the fonts downloaded in the RAM.

• Flash shows all fonts resident in that option. The optional flash
memory card must be properly formatted and cannot be read/write‑,
write‑, or password‑protected.

• All shows the fonts available to any option.

Font Name
Courier 10

Identify a specific font and the option where it is stored.

Note: Courier 10 is the factory default setting. Courier 10 shows the font
name, font ID, and the storage location in the printer. The font source
abbreviation is R for Resident, F for Flash, and D for Download.

Symbol Set
10U PC‑8
12U PC‑850

Specify the symbol set for each font name.

Notes:

• 10U PC‑8 is the U.S. factory default setting. 12U PC‑850 is the
international factory default setting.

• A symbol set is a set of alphabetic and numeric characters,
punctuation, and special symbols. Symbol sets support the different
languages or specific program, such as math symbols for scientific
text. Only the supported symbol sets are shown.

PCL Emulation Settings
Point Size

1.00–1008.00

Change the point size for scalable typographic fonts.

Notes:

• 12 is the factory default setting.

• Point size refers to the height of the characters in the font. One point
equals approximately 0.014 inch.

• Point sizes can be increased or decreased in 0.25‑point increments.

PCL Emulation Settings
Pitch

0.08–100

Specify the font pitch for scalable monospaced fonts.

Notes:

• 10 is the factory default setting.

• Pitch refers to the number of fixed‑space characters per inch (cpi).

• Pitch can be increased or decreased in 0.01‑cpi increments.

• For non‑scalable monospaced fonts, the pitch appears on the
display but it cannot be changed.

PCL Emulation Settings
Orientation

Portrait
Landscape

Specify the orientation of text and graphics on the page.

Notes:

• Portrait is the factory default setting. Portrait prints text and graphics
parallel to the short edge of the page.

• Landscape prints text and graphics parallel to the long edge of the
page.
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PCL Emulation Settings
Lines per Page

1–255

Specify the number of lines that print on each page.

Notes:

• 60 is the U.S. factory default setting. 64 is the international default
setting.

• The printer sets the amount of space between each line based on
the Lines per Page, Paper Size, and Orientation settings. Select the
Paper Size and Orientation you want before setting Lines per Page.

PCL Emulation Settings
A4 Width

198 mm
203 mm

Set the printer to print on A4‑size paper.

Notes:

• 198 mm is the factory default setting.

• The 203‑mm setting sets the width of the page to allow printing of
eighty 10‑pitch characters.

PCL Emulation Settings
Auto CR after LF

On
Off

Specify whether the printer automatically performs a carriage return (CR)
after a line feed (LF) control command.

Note: Off is the factory default setting.

PCL Emulation Settings
Auto LF after CR

On
Off

Specify whether the printer automatically performs a line feed (LF) after a
carriage return (CR) control command.

Note: Off is the factory default setting.

Tray Renumber
Assign Multipurpose Feeder

Off
None
0–199

Assign Tray [x]
Off
None
0–199

Assign Manual Paper
Off
None
0–199

Assign Manual Envelope
Off
None
0–199

Configure the printer to work with printer software or programs that use
different source assignments for trays and feeders.

Notes:

• Off is the factory default setting.

• None cannot be selected. It is only displayed when it is selected by
the PCL 5 interpreter. It also ignores the Select Paper Feed
command.

• 0–199 allows a custom setting to be assigned.
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Tray Renumber
View Factory Defaults

MPF Default = 8
T1 Default = 1
T2 Default = 4
T3 Default = 5
T4 Default = 20
T5 Default = 21
Env Default = 6
MPaper Default = 2
MEnv Default = 3

Display the factory default setting assigned to each tray or feeder.

Tray Renumber
Restore Defaults

Yes
No

Restore all tray and feeder assignments to their factory default settings.

HTML menu

Use To

Font Name
Albertus MT
Antique Olive
Apple Chancery
Arial MT
Avant Garde
Bodoni
Bookman
Chicago
Clarendon
Cooper Black
Copperplate
Coronet
Courier
Eurostile
Garamond
Geneva
Gill Sans
Goudy
Helvetica
Hoefler Text
Intl CG Times
Intl Courier
Intl Univers

Joanna MT
Letter Gothic
Lubalin Graph
Marigold
MonaLisa Recut
Monaco
New CenturySbk
New York
Optima
Oxford
Palatino
StempelGaramond
Taffy
Times
TimesNewRoman
Univers
Zapf Chancery
NewSansMTCS
NewSansMTCT
New SansMTJA
NewSansMTKO

Set the default font for HTML documents.

Note: The Times font is used in HTML documents that do
not specify a font.
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Font Size
1–255 pt

Set the default font size for HTML documents.

Notes:

• 12 pt is the factory default setting.

• Font size can be increased in 1‑point increments.

Scale
1–400%

Scale the default font for HTML documents.

Notes:

• 100% is the factory default setting.

• Scaling can be increased in 1% increments.

Orientation
Portrait
Landscape

Set the page orientation for HTML documents.

Note: Portrait is the factory default setting.

Margin Size
8–255 mm

Set the page margin for HTML documents.

Notes:

• 19 mm is the factory default setting.

• Margin size can be increased in 1‑mm increments.

Backgrounds
Do Not Print
Print

Specify whether to print backgrounds on HTML documents.

Note: Print is the factory default setting.

Image menu

Use To

Auto Fit
On
Off

Select the optimal paper size, scaling, and orientation.

Note: On is the factory default setting. It overrides scaling and orientation
settings for some images.

Invert
On
Off

Invert bitonal monochrome images.

Notes:

• Off is the factory default setting.

• This setting does not apply to GIF or JPEG images.

Scaling
Anchor Top Left
Best Fit
Anchor Center
Fit Height/Width
Fit Height
Fit Width

Scale the image to fit the selected paper size.

Notes:

• Best Fit is the factory default setting.

• When Auto Fit is set to On, Scaling is automatically set to Best Fit.
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Orientation
Portrait
Landscape
Reverse Portrait
Reverse Landscape

Set the image orientation.

Note: Portrait is the factory default setting.

Help menu
The Help menu consists of a series of Help pages that are stored in the printer as PDFs. They contain information
about using the printer and performing printing tasks.

English, French, German, and Spanish translations are stored in the printer.

Use To

Print All Guides Print all the guides.

Print Quality Print information about solving print quality issues.

Printing Guide Print information about loading paper and other specialty media.

Media Guide Print a list of the paper sizes supported in trays and feeders.

Print Defects Guide Print information about resolving print defects.

Menu Map Print a list of the printer control panel menus and settings.

Information Guide Print a guide in locating additional information.

Connection Guide Print information about connecting the printer locally (USB) or to a network.

Moving Guide Print instructions for safely moving the printer.
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Saving money and the environment

Saving paper and toner
Studies show that as much as eighty percent of the carbon footprint of a printer is related to paper usage. You
can significantly reduce your carbon footprint by using recycled paper and the following printing suggestions,
such as printing on both sides of the paper and printing multiple pages on one side of a single sheet of paper.

For information on how you can quickly save paper and energy using one printer setting, see “Using Eco‑Mode”
on page 82.

Conserving supplies

Use both sides of the paper

If your printer model supports two‑sided printing, then you can control whether print appears on one or two
sides of the paper.

Notes:

• Two-sided printing is the default setting in the print driver.

• For a complete list of supported products and countries, go to www.dell.com/support.

Place multiple pages on one sheet of paper

You can print up to 16 consecutive pages of a multiple‑page document onto one side of a single sheet of paper
by setting multiple page printing (N‑Up) for the print job.

Check your first draft for accuracy

Before printing or making multiple copies of a document:

• Use the preview feature to see how the document looks like before you print it.

• Print one copy of the document to check its content and format for accuracy.

Avoid paper jams

Correctly set the paper type and size to avoid paper jams. For more information, see “Avoiding jams” on
page 98.

Saving energy

Using Eco‑Mode
Use Eco‑Mode to quickly select one or more ways to reduce your printer's environmental impact.

1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings >  > Eco‑Mode >  > select the setting you
want
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Use To

Off Use the factory default settings for all settings associated with Eco‑Mode. This setting supports
the performance specifications for your printer.

Energy Reduce energy use, especially when the printer is idle.

Notes:

• Printer engine motors do not start until a job is ready to print. You may notice a short delay
before the first page is printed.

• The printer enters Sleep mode after one minute of inactivity.

Energy/Paper Use all the settings associated with Energy and Paper modes.

Plain Paper • Enable automatic two‑sided (duplex) printing.

• Turn off print log features.

2 Press .

Reducing printer noise
Enable Quiet mode to reduce the printer noise.

1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings >  > Quiet Mode > 

2 Select a setting.

Use To

On Reduce printer noise.

Notes:

• Print jobs process at a reduced speed.

• Printer engine motors do not start until a
document is ready to print. There is a short delay
before the first page is printed.

• The alarm control and cartridge alarm sounds are
turned off.

• The printer ignores the Advance Start command.

Off Use factory default settings.

Note: This setting supports the performance
specifications of the printer.

3 Press .
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Adjusting Sleep Mode
1 From the printer control panel, navigate to:

 > Settings >  > Settings >  > General Settings >  > Timeouts >  > Sleep Mode > 

2 Set the time that the printer stays idle before it enters Sleep Mode.

3 Apply the changes.

Using Hibernate mode
Hibernate is an ultra‑low‑power saving mode.

Notes:

• Three days is the default amount of time before the printer enters Hibernate mode.

• Make sure to wake the printer from Hibernate mode before sending a print job. A hard reset or a long
press of the Sleep button wakes the printer from Hibernate mode.

• If the printer is in Hibernate mode, then the Embedded Web Server is disabled.

1 From the control panel, navigate to:

 > Settings >  > Settings >  > General Settings > 

2 Select Press Sleep Button or Press and Hold Sleep Button, and then press .

3 Press Hibernate > .

Adjusting the brightness of the printer display
To save energy, or if you have trouble reading the display, adjust its brightness settings.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears
as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > General Settings.

3 In the Screen Brightness field, enter the brightness percentage you want for the display.

4 Click Submit.
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Using Schedule Power Modes
Schedule Power Modes lets you schedule when the printer goes into a reduced power state or into the Ready
state.

Note: This feature is available only in network printers or printers connected to print servers.

Using the Embedded Web Server

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears
as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > General Settings > Schedule Power Modes.

3 From the Action menu, select the power mode.

4 From the Time menu, select the time.

5 From the Day(s) menu, select the day or days.

6 Click Add.

Recycling

Recycling Dell products
To return Dell products for recycling:

1 Visit our Web site at www.dell.com/recycle.

2 Select your country or region.

3 Follow the instructions on the computer screen.
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Securing the printer

Using the security lock feature
The printer is equipped with a security lock feature. Attach a security lock compatible with most laptop
computers in the location shown to secure the printer in place.

Statement of Volatility
Your printer contains various types of memory that can store device and network settings, and user data.

Type of memory Description

Volatile memory Your printer uses standard random access memory
(RAM) to temporarily buffer user data during simple print
jobs.

Non-volatile memory Your printer may use two forms of non-volatile memory:
EEPROM and NAND (flash memory). Both types are used
to store operating system, device settings, and network
information.

Erase the content of any installed printer memory in the following circumstances:

• The printer is being decommissioned.

• The printer is being moved to a different department or location.

• The printer is being serviced by someone from outside your organization.

• The printer is being removed from your premises for service.

• The printer is being sold to another organization.

Erasing volatile memory
The volatile memory (RAM) installed in your printer requires a power source to retain information. To erase the
buffered data, simply turn off the printer.

Securing the printer 86



Erasing non‑volatile memory
Erase individual settings, device and network settings, security settings, and embedded solutions by following
these steps:

1 Turn off the printer.

2 Hold down 2 and 6 on the keypad while turning the printer on. Release the buttons only when the screen
with the progress bar appears.

The printer performs a power-on sequence, and then the Configuration menu appears. When the printer is
fully turned on, a list of functions appears on the printer display.

3 Press the up or down arrow button until Wipe All Settings appears.

The printer will restart several times during this process.

Note: Wipe All Settings securely removes device settings, solutions, jobs, and passwords from the printer
memory.

4 Navigate to:

Back > Exit Config Menu

The printer will perform a power‑on reset, and then return to normal operating mode.
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Maintaining the printer
Warning—Potential Damage: Failure to replace parts and supplies when directed may cause damage to
your printer or prevent the printer from performing optimally.

Cleaning the printer
Note: You may need to perform this task after every few months.

Warning—Potential Damage: Damage to the printer caused by improper handling is not covered by the
printer warranty.

1 Make sure that the printer is turned off and unplugged from the electrical outlet.

CAUTION—SHOCK HAZARD: To avoid the risk of electrical shock when cleaning the exterior of the
printer, unplug the power cord from the electrical outlet and disconnect all cables from the printer
before proceeding.

2 Remove paper from the standard bin and multipurpose feeder.

3 Remove any dust, lint, and pieces of paper around the printer using a soft brush or vacuum.

4 Dampen a clean, lint-free cloth with water, and use it to wipe the outside of the printer.

Warning—Potential Damage: Do not use household cleaners or detergents to prevent damage to the
exterior of the printer.

5 Make sure all areas of the printer are dry before sending a new print job.

Checking the status of parts and supplies on the printer
control panel
From the printer control panel, navigate to:

 > Status/Supplies >  > View Supplies > 

Estimated number of remaining pages
The estimated number of remaining pages is based on the recent printing history of the printer. Its accuracy
may vary significantly and is dependent on many factors, such as actual document content, print quality settings,
and other printer settings.

The accuracy of the estimated number of remaining pages may decrease when the actual printing consumption
is different from the historical printing consumption. Consider the variable level of accuracy before purchasing
or replacing supplies based on the estimate. Until an adequate print history is obtained on the printer, initial
estimates assume future supplies consumption based on the International Organization for Standardization*
test methods and page content.

* Average continuous black declared cartridge yield in accordance with ISO/IEC 19752.
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Ordering supplies

Ordering supplies using Printer Home
1 Use the Search command on the Start menu to locate Dell Printer Home.

2 Open the application, and then click Maintenance > Order supplies.

Storing supplies
Choose a cool, clean storage area for the printer supplies. Store supplies right side up in their original packing
until you are ready to use them.

Do not expose supplies to:

• Direct sunlight

• Temperatures above 35°C (95°F)

• High humidity above 80%

• Salty air

• Corrosive gases

• Heavy dust

Replacing supplies

Replacing the toner cartridge
1 Press the button on the right side of the printer, and then open the front door.
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2 Pull the toner cartridge out using the handle.

3 Unpack the toner cartridge, and then remove all packing materials.

4 Shake the new cartridge to redistribute the toner.

5 Insert the toner cartridge into the printer by aligning the side rails of the cartridge with the arrows on the
side rails inside the printer.

Warning—Potential Damage: Do not expose the imaging unit to direct light for more than 10 minutes.
Extended exposure to light may cause print quality problems.

6 Close the front door.
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Replacing the imaging unit
1 Press the button on the right side of the printer, and then open the front door.

2 Pull the toner cartridge out using the handle.
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3 Lift the blue handle, and then pull the imaging unit out of the printer.

4 Unpack the new imaging unit, and then shake it.

5 Remove all packing materials from the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to direct light for more than 10 minutes.
Extended exposure to light may cause print quality problems.

Warning—Potential Damage: Do not touch the photoconductor drum. Doing so may affect the print
quality of future print jobs.
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6 Insert the imaging unit into the printer by aligning the arrows on the side rails of the imaging unit with the
arrows on the side rails inside the printer.

7 Insert the toner cartridge into the printer by aligning the side rails of the cartridge with the arrows on the
side rails inside the printer.

8 Close the front door.

Moving the printer

Before moving the printer
CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid personal
injury or printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the electrical outlet.

• Disconnect all cords and cables from the printer before moving it.
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• If an optional tray is installed, then remove it from the printer. To remove the optional tray, slide the latch on
the right side of the tray toward the front of the tray until it clicks into place.

• Use the handholds located on both sides of the printer to lift it.

• Make sure your fingers are not under the printer when you set it down.

• Before setting up the printer, make sure there is adequate clearance around it.

Use only the power cord provided with this product or the manufacturer's authorized replacement.

Warning—Potential Damage: Damage to the printer caused by improper moving is not covered by the
printer warranty.

Moving the printer to another location
The printer and its hardware options can be safely moved to another location by following these precautions:

• Any cart used to move the printer must have a surface able to support the full footprint of the printer.

• Any cart used to move the hardware options must have a surface able to support the dimensions of the
hardware options.

• Keep the printer in an upright position.

• Avoid severe jarring movements.

Shipping the printer
When shipping the printer, use the original packaging.
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Managing the printer

Accessing the remote control panel
The remote control panel on your computer screen lets you interact with the printer control panel, even when
you are not physically near the network printer. From your screen, you can view the printer status and do print-
related tasks.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• Print a network setup page or menu settings page, and then locate the IP address in the TCP/IP
section. The IP address appears as four sets of numbers separated by periods, such as
123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Press Enter to open the Web page of your printer.

3 Click Remote Operator Panel > Run Remote Panel.

Note: The remote control panel requires a Java plug‑in to launch.

Viewing reports
You can view some reports from the Embedded Web Server. These reports are useful for assessing the status
of the printer, network, and supplies.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears
as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Reports, and then click the type of report you want to view.

Configuring supply notifications from the Embedded Web
Server
You can determine how you would like to be notified when supplies run nearly low, low, very low, or reach their
end‑of‑life by setting the selectable alerts.

Notes:

• Selectable alerts can be set on the toner cartridge and imaging unit.

• All selectable alerts can be set for nearly low, low, and very low supply conditions. Not all selectable
alerts can be set for the end‑of‑life supply condition. E‑mail selectable alert is available for all supply
conditions.
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• The percentage of estimated remaining supply that prompts the alert can be set on some supplies for
some supply conditions.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears
as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Print Settings > Supply Notifications.

3 From the drop‑down menu for each supply, select one of the following notification options:

Notification Description

Off The normal printer behavior for all supplies occurs.

SNMP Only The printer generates a simple network management protocol (SNMP) alert when the
supply condition is reached. The status of the supply will appear on the menus page
and status page.

E‑mail Only The printer generates an e-mail when the supply condition is reached. The status of
the supply will appear on the menus page and status page.

Warning The printer displays the warning message and generates an e‑mail about the status
of the supply. The printer does not stop when the supply condition is reached.

Continuable Stop1 The printer stops processing jobs when the supply condition is reached, and the user
needs to press a button to continue printing.

Non Continuable Stop1,2 The printer stops when the supply condition is reached. The supply must be replaced
to continue printing.

1 The printer generates an e-mail about the status of the supply when supply notification is enabled.
2 The printer stops when some supplies become empty to prevent damage.

4 Click Submit.

Copying printer settings to other printers
Note: This feature is available only in network printers.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears
as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click the Copy Printer Settings.

3 To change the language, select a language from the drop-down menu, and then click Click here to submit
language.

4 Click Printer Settings.
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5 Type the IP addresses of the source and target printers in their appropriate fields.

Note: If you want to add or remove a target printer, then click Add Target IP or Remove Target IP.

6 Click Copy Printer Settings.

Restoring factory default settings
If you want to keep a list of the current menu settings for reference, then print a menu settings page before
restoring the factory default settings. For more information, see “Printing a menu settings page” on page 22.

If you want a more comprehensive method of restoring the printer factory default settings, then perform the
Wipe All Settings option. For more information, see “Erasing non‑volatile memory” on page 87.

Warning—Potential Damage: Restoring factory defaults returns most printer settings to the original factory
default settings. Exceptions include the display language, custom sizes and messages, and network/port
menu settings. All downloads stored in the RAM are deleted. Downloads stored in the flash memory card are
not affected.

From the control panel, navigate to:

 > Settings > Settings >  > General Settings >  > Factory Defaults >  > Restore Now > 

Creating a printer control panel PIN
The Panel PIN Protect menu lets you restrict access to the menus from the printer control panel. To restrict
access to the menus, create a Personal Identification Number (PIN), and then assign the PIN to each menu.

1 Open a Web browser, and then type the printer IP address in the address field.

Notes:

• View the printer IP address in the TCP/IP section in the Network/Ports menu. The IP address appears
as four sets of numbers separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.

2 Click Settings > Security > Panel PIN Protect.

3 From the Create User PIN or Create Admin PIN sections, enter your PIN.

Note: Your can enter up to 16 digits for your PIN.

4 Click Modify.

5 From any menu in the Administrative Menus, Management, or Function Access sections, select User PIN
Protected or Admin PIN Protected or Admin PIN and User PIN Protected.

Note: Using an Admin PIN, you can still access a menu assigned with a User PIN.

6 Click Submit.

If you try to access a PIN‑protected menu from the printer control panel, the printer will require you to enter
the PIN.

Note: After you enter the last digit of the PIN, make sure to press  on the printer control panel for more
than three seconds.
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Clearing jams
Note: Jam Recovery is set to Auto by default. The printer reprints jammed pages unless the memory
required to hold the pages is needed for other printer tasks.

Avoiding jams

Load paper properly
• Make sure paper lies flat in the tray.

Correct loading of paper Incorrect loading of paper

• Do not remove a tray while the printer is printing.

• Do not load a tray while the printer is printing. Load it before printing, or wait for a prompt to load it.

• Do not load too much paper. Make sure the stack height is below the maximum paper fill indicator.

• Do not slide the paper into the tray. Load paper as shown in the illustration.

• Make sure the guides in the tray or the multipurpose feeder are properly positioned and are not pressing
tightly against the paper or envelopes.

• Push the tray firmly into the printer after loading paper.
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Use recommended paper
• Use only recommended paper or specialty media.

• Do not load wrinkled, creased, damp, bent, or curled paper.

• Flex, fan, and straighten paper before loading it.

• Do not use paper that has been cut or trimmed by hand.

• Do not mix paper sizes, weights, or types in the same tray.

• Make sure the paper size and type are set correctly on the computer or printer control panel.

• Store paper according to manufacturer recommendations.

Identifying jam locations
Notes:

• When Jam Assist is set to On, the printer automatically flushes blank pages or pages with partial prints
after a jammed page has been cleared. Check your printed output for blank pages.

• When Jam Recovery is set to On or Auto, the printer reprints jammed pages.

Jam location

1 Standard bin

2 Multipurpose feeder

3 Tray 1

4 Tray [x]

5 Front door

6 Rear door
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Paper jam in the front door
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching it.

1 Open the front door.

2 Remove the toner cartridge.
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3 Remove the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit to direct light for more than 10 minutes.
Extended exposure to light may cause print quality problems.

Warning—Potential Damage: Do not touch the shiny photoconductor drum under the imaging unit.
Doing so may affect the quality of future print jobs.

4 Remove the jammed paper.

Note: Make sure that all paper fragments are removed.

5 Insert the imaging unit.

Note: Use the arrows inside the printer as guides.
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6 Insert the toner cartridge.

7 Close the front door.

8 From the control panel, press .

Paper jam in the rear door
1 Open the rear door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a
hot component, allow the surface to cool before touching it.
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2 Remove the jammed paper.

Note: Make sure that all paper fragments are removed.

3 Close the rear door.

4 From the control panel, press .

Paper jam in the standard bin
1 Remove the jammed paper.

Note: Make sure that all paper fragments are removed.

Clearing jams 103



2 From the control panel, press .

Paper jam in the duplex unit
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching it.

1 Pull out the tray.

2 Remove the jammed paper.

Note: Make sure that all paper fragments are removed.

3 Insert the tray.

4 From the control panel, press .
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Paper jam in trays
1 Remove the tray.

2 Remove the jammed paper.

Note: Make sure that all paper fragments are removed.

3 Insert the tray.

4 From the control panel, press .

Paper jam in the multipurpose feeder
1 Remove the jammed paper.

Note: Make sure that all paper fragments are removed.
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2 From the control panel, press .
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Troubleshooting

Understanding the printer messages

Change [paper source] to [custom string] load [orientation]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then press  on the control panel.

Note: Make sure the paper size and type settings are specified in the Paper menu on the control
panel.

• Select Use current [paper source] on the control panel to clear the message and continue printing
using the current size and type of paper in the tray.

• Cancel the print job.

Change [paper source] to [custom type name] load [orientation]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then press  on the control panel.

Note: Make sure the paper size and type settings are specified in the Paper menu on the control
panel.

• Select Use current [paper source] on the control panel to clear the message and continue printing
using the current size and type of paper in the tray.

• Cancel the print job.

Change [paper source] to [paper size] load [orientation]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then press  on the control panel.

Note: Make sure the paper size and type settings are specified in the Paper menu on the control
panel.

• Select Use current [paper source] on the control panel to clear the message and continue printing
using the current size and type of paper in the tray.

• Cancel the print job.
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Change [paper source] to [paper type] [paper size] load [orientation]
Try one or more of the following:

• Load the correct size and type of paper in the tray, and then press  on the control panel.

Note: Make sure the paper size and type settings are specified in the Paper menu on the control
panel.

• Select Use current [paper source] on the control panel to clear the message and continue printing
using the current size and type of paper in the tray.

• Cancel the print job.

Complex page, some data may not have printed [39]
Try one or more of the following:

• From the printer control panel, press  to clear the message and continue printing.

• Reduce the number and size of fonts, the number and complexity of images, and the number of pages
in the print job.

• Cancel the print job.

• Install additional printer memory.

Some held jobs were not restored [57]

From the control panel, press  to clear the message and continue printing.

Defective flash detected [51]
Try one or more of the following:

• Replace the defective flash memory card.

• From the printer control panel, press  to ignore the message and continue printing.

• Cancel the current print job.

Incorrect paper size, open [paper source] [34]
Note: The paper source can be a tray or a feeder.

Try one or more of the following:

• Load the correct size of paper in the paper source.

• From the control panel, press  to clear the message and print using a different paper source.

• Check the length and width guides of the paper source and make sure the paper is loaded properly.

• Make sure the correct paper size and type are specified in the Printing Preferences or in the Print dialog.

• Make sure the paper size and type are specified in the Paper menu on the control panel.

Troubleshooting 108



• Make sure that the paper size is correctly set. For example, if Multipurpose Feeder Size is set to
Universal, then make sure the paper is large enough for the data being printed.

• Cancel the print job.

Insufficient memory to support Resource Save feature [35]
Try one or more of the following:

• From the printer control panel, press  to disable Resource Save, clear the message, and continue
printing.

• Install additional printer memory.

Insufficient memory to collate job [37]
Try one or more of the following:

• From the printer control panel, press  to print the portion of the job already stored and begin
collating the rest of the print job.

• Cancel the current print job.

Insufficient memory, some Held Jobs were deleted [37]

From the printer control panel, press  to clear the message.

Insufficient memory, some held jobs will not be restored [37]
Do either of the following:

• From the printer control panel, press  to clear the message.

• Delete other held jobs to free up additional printer memory.

Load multipurpose feeder with [custom type name] [orientation]
Try one or more of the following:

• Load the multipurpose feeder with the correct size and type of paper.

• From the control panel, press  to clear the message and continue printing.

Note: If no paper is loaded in the multipurpose feeder, the printer manually overrides the request,
and then prints from an automatically selected tray.

• Cancel the current job.
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Network [x] software error [54]
Try one or more of the following:

• From the control panel, press  to continue printing.

• Turn off the printer, wait for about 10 seconds, and then turn the printer back on.

Non‑Dell [supply type], see User’s Guide [33.xy]
Note: The supply type can either be a toner cartridge or imaging unit.

The printer has detected a non‑Dell supply or part installed in the printer.

Your Dell printer is designed to function best with genuine Dell supplies and parts. Use of third-party supplies
or parts may affect the performance, reliability, or life of the printer and its imaging components.

All life indicators are designed to function with Dell supplies and parts, and may deliver unpredictable results
if third-party supplies or parts are used. Imaging component usage beyond the intended life may damage
your Dell printer or associated components. 

Warning—Potential Damage: Use of third-party supplies or parts can affect warranty coverage.
Damage caused by the use of third-party supplies or parts are not covered by the warranty.

To accept any and all of these risks and to proceed with the use of non-genuine supplies or parts in your

printer, press  and  on the printer control panel simultaneously for 15 seconds to clear the message
and continue printing.

If you do not wish to accept these risks, then remove the third-party supply or part from your printer, and
then install a genuine Dell supply or part.

Note: For the list of supported supplies, see the “Ordering supplies” section of the User's Guide or visit
www.dell.com/printers.

Not enough free space in flash memory for resources [52]
Try one or more of the following:

• From the printer control panel, press  to clear the message and continue printing.

• Delete fonts, macros, and other data stored in the flash memory.

From the printer control panel, navigate to:

 > Settings >  > Settings >  > Print Settings >  > Utilities Menu >  > Format Flash

>  > Yes > 

• Use a larger‑capacity flash memory card.

Note: Downloaded fonts and macros that are not stored in the flash memory are deleted when the printer
is turned off or restarted.

Printer had to restart. Last job may be incomplete.
From the printer control panel, select Continue to clear the message and continue printing.

For more information, visit http://support.dell.com or contact technical support.
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Remove paper from standard output bin
Remove the paper stack from the standard bin.

Standard network software error [54]
Try one or more of the following:

• From the printer control panel, press  to confirm.

• Unplug the router, then wait for 30 seconds, and then plug it back again.

• Turn off the printer, and then turn it back on.

• Update the network firmware in the printer or the print server. For more information, visit the Dell
Support Web site at http://support.dell.com contact your system support person.

Parallel port disabled [56]

• From the control panel, press  to clear the message.

Notes:

• The printer discards any data received through the parallel port.

• Make sure that the Parallel Buffer menu is not set to Disabled.

Standard USB port disabled [56]
Try one or more of the following:

• From the printer control panel, press  to clear the message and continue printing.

Note: The printer discards any data received through the USB port.

• From the printer control panel, set USB Buffer to Auto.

Too many trays attached [58]
1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the extra trays.

4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.

Unformatted flash detected [53]
Try one or more of the following:

• From the printer control panel, press  to stop the defragmentation and continue printing.

• Format the flash memory device.
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Note: If the error message remains, then the flash memory device may be defective and need to be
replaced.

Unsupported option in slot [x] [55]
1 Turn off the printer.

2 Unplug the power cord from the electrical outlet.

3 Remove the unsupported option card from the printer controller board, and then replace it with a
supported card.

4 Connect the power cord to a properly grounded electrical outlet.

5 Turn the printer back on.

Cartridge low [88.xy]

You may need to order a toner cartridge. If necessary, press  on the printer control panel to clear the
message and continue printing.

Cartridge nearly low [88.xy]

If necessary, press  on the printer control panel to clear the message and continue printing.

Cartridge very low, [x] estimated pages remain [88.xy]
You may need to replace a toner cartridge very soon. For more information, see the “Replacing supplies” section
of the User’s Guide.

If necessary, press  on the printer control panel to clear the message and continue printing.

Close front door
Close the front door of the printer.

Imaging unit low [84.xy]

You may need to order an imaging unit. If necessary, press  on the printer control panel to clear the message
and continue printing.

Imaging unit nearly low [84.xy]

If necessary, press  on the printer control panel to clear the message and continue printing.
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Imaging unit very low, [x] estimated pages remain [84.xy]
You may need to replace the imaging unit very soon. For more information, see the “Replacing supplies” section
of the User’s Guide.

If necessary, press  on the printer control panel to clear the message and continue printing.

Insert tray [x]
Insert the indicated tray into the printer.

Load [paper source] with [custom string] [orientation]
Try one or more of the following:

• Load the indicated tray or feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If the printer finds a tray that has the correct paper type and size, then it feeds from that tray. If
the printer cannot find a tray that has the correct size and type of paper, then it prints from the
default paper source.

• Cancel the current job.

Load [paper source] with [custom type name] [orientation]
Try one or more of the following:

• Load the tray or feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If the printer finds a tray that has the correct size and type of paper, then it feeds from that
tray. If the printer cannot find a tray that has the correct size and type of paper, then it prints from the
default paper source.

• Cancel the current job.

Load [paper source] with [paper size] [orientation]
Try one or more of the following:

• Load the tray or feeder with the correct size of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If the printer finds a tray that has the correct paper size, then it feeds from that tray. If the
printer cannot find a tray that has the correct size of paper, then it prints from the default paper
source.

• Cancel the current job.
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Load [paper source] with [paper type] [paper size] [orientation]
Try one or more of the following:

• Load the tray or feeder with the correct size and type of paper.

• From the printer control panel, press  to clear the message and continue printing.

Note: If the printer finds a tray that has the correct size and type of paper, then it feeds from that
tray. If the printer cannot find a tray that has the correct size and type of paper, then it prints from the
default paper source.

• Cancel the current job.

Memory full [38]
Try one or more of the following:

• From the printer control panel, press  to clear the message.

• Decrease the resolution setting.

• Install additional printer memory.

Reinstall missing or unresponsive cartridge [31.xy]
Try one or more of the following:

• Check if the toner cartridge is missing. If missing, install the toner cartridge.

For information on installing the cartridge, see the “Replacing supplies” section of the User’s Guide.

• If the toner cartridge is installed, then remove the unresponsive toner cartridge, and then reinstall it.

Note: If the message appears after reinstalling the supply, then the cartridge is defective. Replace
the toner cartridge.

Reinstall missing or unresponsive imaging unit [31.xy]
Try one or more of the following:

• Check if the imaging unit is missing. If missing, install the imaging unit.

For information on installing the imaging unit, see the “Replacing supplies” section of the User’s Guide.

• If the imaging unit is installed, then remove the unresponsive imaging unit, and then reinstall it.

Note: If the message appears after reinstalling the supply, then the imaging unit is defective.
Replace the imaging unit.

Replace cartridge, 0 estimated pages remain [88.xy]
Replace the toner cartridge to clear the message and continue printing. For more information, see the
instruction sheet that came with the supply or see the “Replacing supplies” section of the User’s Guide.

Note: If you do not have a replacement cartridge, then visit our Web site or contact the place where you
purchased the printer.
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Replace cartridge, printer region mismatch [42.xy]
Install a suitable toner cartridge.

Replace imaging unit, 0 estimated pages remain [84.xy]
Replace the imaging unit to clear the message and continue printing. For more information, see the
instruction sheet that came with the supply or see the “Replacing supplies” section of the User’s Guide.

Note: If you do not have a replacement imaging unit, then visit our Web site or contact the place where
you purchased the printer.

Replace unsupported cartridge [32.xy]
Remove the toner cartridge, and then install a supported one to clear the message and continue printing.
For more information, see the instruction sheet that came with the supply or see the “Replacing supplies”
section of the User’s Guide.

Note: If you do not have a replacement cartridge, then visit our Web site or contact the place where you
purchased the printer.

Replace unsupported imaging unit [32.xy]
Remove the imaging unit, and then install a supported one to clear the message and continue printing. For
more information, see the instruction sheet that came with the supply or see the “Replacing supplies” section
of the User’s Guide.

Note: If you do not have a replacement imaging unit, then visit our Web site or contact the place where
you purchased the printer.

Solving printer problems
• “Basic printer problems” on page 116

• “Option problems” on page 118

• “Paper feed problems” on page 120
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Basic printer problems

The printer is not responding

Action Yes No

Step 1

Make sure the printer is turned on.

Is the printer turned on?

Go to step 2. Turn on the printer.

Step 2

Check if the printer is in Sleep mode or Hibernate mode.

Is the printer in Sleep mode or Hibernate mode?

Press the Sleep
button to wake the
printer from Sleep
mode or Hibernate
mode.

Go to step 3.

Step 3

Check if one end of the power cord is plugged into the printer and
the other to a properly grounded electrical outlet.

Is the power cord plugged into the printer and a properly grounded
electrical outlet?

Go to step 4. Plug one end of the
power cord into the
printer and the other
to a properly
grounded electrical
outlet.

Step 4

Check other electrical equipment plugged into the electrical outlet.

Does other electrical equipment work?

Unplug the other
electrical equipment,
and then turn on the
printer. If the printer
does not work, then
reconnect the other
electrical equipment.

Go to step 5.

Step 5

Check if the cables connecting the printer and the computer are
inserted in the correct ports.

Are the cables inserted in the correct ports?

Go to step 6. Make sure to match
the following:

• The USB symbol
on the cable with
the USB symbol
on the printer

• The appropriate
Ethernet cable
with the Ethernet
port

Step 6

Make sure the electrical outlet is not turned off by a switch or
breaker.

Is the electrical outlet turned off by a switch or breaker?

Turn on the switch or
reset the breaker.

Go to step 7.
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Action Yes No

Step 7

Check if the printer is plugged into any surge protectors,
uninterruptible power supplies, or extension cords.

Is the printer plugged into any surge protectors, uninterruptible
power supplies, or extension cords?

Connect the printer
power cord directly
to a properly
grounded electrical
outlet.

Go to step 8.

Step 8

Check if one end of the printer cable is plugged into a port on the
printer and the other to the computer, print server, option, or other
network device.

Is the printer cable securely attached to the printer and the
computer, print server, option, or other network device?

Go to step 9. Connect the printer
cable securely to the
printer and the
computer, print
server, option, or
other network
device.

Step 9

Make sure to install all hardware options properly and remove any
packing material.

Are all hardware options properly installed and all packing material
removed?

Go to step 10. Turn off the printer,
remove all packing
materials, then
reinstall the
hardware options,
and then turn on the
printer.

Step 10

Check if you have selected the correct port settings in the printer
driver.

Are the port settings correct?

Go to step 11. Use correct printer
driver settings.

Step 11

Check the installed printer driver.

Is the correct printer driver installed?

Go to step 12. Install the correct
printer driver.

Step 12

Turn off the printer, then wait for about 10 seconds, and then turn
the printer back on.

Is the printer working?

The problem is
solved.

Contact technical
support.
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Printer display is blank

Action Yes No

Step 1

Press the Sleep button on the printer control panel.

Does Ready appear on the printer display?

The problem is
solved.

Go to step 2.

Step 2

Turn off the printer, then wait for about 10 seconds, and then turn
the printer back on.

Do Please wait and Ready appear on the printer display?

The problem is
solved.

Turn off the printer,
and then contact
technical support.

Option problems

Cannot detect internal option

Action Yes No

Step 1

Turn off the printer, then wait for about 10 seconds, and then turn
on the printer.

Does the internal option operate correctly?

The problem is
solved.

Go to step 2.

Step 2

Check if the internal option is properly installed in the controller
board.

a Turn off the printer using the power switch, and then unplug the
power cord from the electrical outlet.

b Make sure the internal option is installed in the appropriate
connector in the controller board.

c Connect the power cord to the printer, then to a properly
grounded electrical outlet, and then turn on the printer.

Is the internal option properly installed in the controller board?

Go to step 3. Connect the internal
option to the
controller board.

Step 3

Print a menu settings page, and then check to see if the internal
option is listed in the Installed Features list.

Is the internal option listed in the menu settings page?

Go to step 4. Reinstall the internal
option.
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Action Yes No

Step 4
a Check if the internal option is selected.

It may be necessary to manually add the internal option in the
printer driver to make it available for print jobs. For more
information, see “Adding available options in the print driver”
on page 19.

b Resend the print job.

Does the internal option operate correctly?

The problem is
solved.

Contact technical
support.

Tray problems

Action Yes No

Step 1
a Open the tray and do one or more of the following:

• Check for paper jams or misfeeds.

• Check if the paper size indicators on the paper guides are
aligned with the paper size indicators on the tray.

• If you are printing on custom‑size paper, then make sure
that the paper guides rest against the edges of the paper.

• Make sure the paper is below the maximum paper fill
indicator.

• Make sure paper lies flat in the tray.

b Check if the tray closes properly.

Is the tray working?

The problem is
solved.

Go to step 2.

Step 2
a Turn off the printer, then wait about 10 seconds, and then turn

the printer back on.

b Resend the print job.

Is the tray working?

The problem is
solved.

Go to step 3.

Step 3

Check if the tray is installed and recognized by the printer.
Print a menu settings page, and then check if the tray is listed
in the Installed Features list.

Is the tray listed in the menu settings page?

Go to step 4. Reinstall the tray. For
more information,
see the setup
documentation that
came with the tray.
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Action Yes No

Step 4

Check if the tray is available in the printer driver.

Note: If necessary, manually add the tray in the printer driver to
make it available for print jobs. For more information, see
“Adding available options in the print driver” on page 19.

Is the tray available in the printer driver?

Go to step 5. Manually add the
tray in the printer
driver.

Step 5

Check if the option is selected.

a From the application you are using, select the option. For Mac
OS X version 9 users, make sure the printer is set up in Chooser.

b Resend the print job.

Is the tray working?

The problem is
solved.

Contact technical
support.

Paper feed problems

Paper frequently jams

Action Yes No

Step 1
a Pull out the tray, and then do one or more of the following:

• Make sure paper lies flat in the tray.

• Check if the paper size indicators on the paper guides are
aligned with the paper size indicators on the tray.

• Check if the paper guides are aligned against the edges of
the paper.

• Make sure the paper is below the maximum paper fill
indicator.

• Check if you are printing on a recommended paper size and
type.

b Insert the tray properly.

If jam recovery is enabled, then the print jobs will reprint
automatically.

Do paper jams still occur frequently?

Go to step 2. The problem is
solved.

Step 2
a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store
paper in its original wrapper until you use it.

b Resend the print job.

Do paper jams still occur frequently?

Go to step 3. The problem is
solved.
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Action Yes No

Step 3
a Review the tips on avoiding jams. For more information, see

“Avoiding jams” on page 98.

b Follow the recommendations, and then resend the print job.

Do paper jams still occur frequently?

Contact technical
support.

The problem is
solved.

Paper jam message remains after jam is cleared

Action Yes No

a From the printer control panel, navigate to:

Next >  > Clear the jam, press OK > 

b Follow the instructions on the printer display.

Does the paper jam message remain?

Contact technical
support.

The problem is
solved.

Jammed pages are not reprinted

Action Yes No

a Turn on jam recovery.

1 From the control panel, navigate to:

Settings > General Settings > Print Recovery > Jam
Recovery

2 Select On or Auto.

3 Depending on your printer model, press .

b Resend the pages that did not print.

Were the jammed pages reprinted?

The problem is
solved.

Contact technical
support.
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Solving print problems

Printing problems

Print jobs do not print

Action Yes No

Step 1
a From the document you are trying to print, open the Print dialog

and check if you have selected the correct printer.

Note: If the printer is not the default printer, then you must
select the printer for each document that you want to print.

b Resend the print job.

Do the jobs print?

The problem is
solved.

Go to step 2.

Step 2
a Check if the printer is plugged in and turned on, and if Ready

appears on the printer display.

b Resend the print job.

Do the jobs print?

The problem is
solved.

Go to step 3.

Step 3

If an error message appears on the printer display, then clear the
message.

Note: The printer continues to print after clearing the message.

Do the jobs print?

The problem is
solved.

Go to step 4.

Step 4
a Check if the ports (USB, serial, or Ethernet) are working and if

the cables are securely connected to the computer and the
printer.

Note: For more information, see the setup documentation
that came with the printer.

b Resend the print job.

Do the jobs print?

The problem is
solved.

Go to step 5.

Step 5
a Turn off the printer, then wait for about 10 seconds, and then

turn the printer back on.

b Resend the print job.

Do the jobs print?

The problem is
solved.

Go to step 6.
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Action Yes No

Step 6
a Remove, and then reinstall the printer software. For more

information, see “Installing the printer” on page 18.

Note: For more information, visit
www.dell.com/support/printers.

b Resend the print job.

Do the jobs print?

The problem is
solved.

Contact technical
support.

Printing slows down

Notes:

• When printing using narrow paper, the printer prints at a reduced speed to prevent damage to the fuser.

• The printer speed may be reduced when printing for long periods of time, or printing at elevated
temperatures.

• The printer speed may also be reduced when the printed output resolution is set to 1,200 dpi.

Action Yes No

Place letter‑ or A4‑size paper in the tray, and then resend the print
job.

Does the print speed increase?

The problem is
solved.

Contact technical
support.

Print job takes longer than expected

Action Yes No

Step 1

Change the environmental settings of the printer.

a From the control panel, navigate to:

Settings > General Settings
b Select Eco‑Mode or Quiet Mode, and then select Off.

Note: Disabling Eco-Mode or Quiet Mode may increase the
consumption of energy or supplies, or both.

Did the job print?

The problem is
solved.

Go to step 2.

Step 2

Reduce the font size, the number and complexity of images, and
the number of pages in the print job, and then resend the job

Did the job print?

The problem is
solved.

Go to step 3.
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Action Yes No

Step 3
a Remove held jobs stored in the printer memory.

b Resend the print job.

Did the job print?

The problem is
solved.

Go to step 4.

Step 4
a Disable the Page Protect feature.

From the control panel, navigate to:

Settings > General Settings > Print Recovery > Page Protect
> Off

b Resend the print job.

Did the job print?

The problem is
solved.

Go to step 5.

Step 5

Install additional printer memory, and then resend the print job.

Did the job print?

The problem is
solved.

Contact technical
support.

Job prints from the wrong tray or on the wrong paper

Action Yes No

Step 1
a Check if you are printing on paper that is supported by the tray.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is
solved.

Go to step 2.

Step 2
a From the Paper menu on the printer control panel, set the paper

size and type to match the paper loaded in the tray.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is
solved.

Go to step 3.

Step 3
a Depending on your operating system, open Printing

Preferences or the Print dialog, and then specify the paper type.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is
solved.

Go to step 4.

Step 4
a Check if the trays are not linked.

b Resend the print job.

Did the job print from the correct tray or on the correct paper?

The problem is
solved.

Contact technical
support.
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Incorrect characters print

Action Yes No

Step 1

Make sure the printer is not in Hex Trace mode.

Note: If Ready Hex appears on the printer display, then turn off
the printer, and then turn it back on to deactivate Hex Trace
mode.

Is the printer in Hex Trace mode?

Deactivate Hex
Trace mode.

Go to step 2.

Step 2
a From the printer control panel, select Standard Network or

Network [x], and then set SmartSwitch to On.

b Resend the print job.

Do incorrect characters print?

Contact technical
support.

The problem is
solved.

Tray linking does not work

Note: The trays and the multipurpose feeder do not automatically detect the paper size. You must set
the size from the Paper Size/Type menu.

Action Yes No

a From the printer control panel, set the paper size and type in
the Paper menu to match the paper loaded in the trays to be
linked.

Note: The paper size and type must match for trays to be
linked.

b Resend the print job.

Do the trays link correctly?

The problem is
solved.

Contact technical
support.

Large jobs do not collate

Action Yes No

Step 1
a From the Finishing menu on the printer control panel, set

Collate to (1,2,3) (1,2,3).

b Resend the print job.

Did the job print and collate correctly?

The problem is
solved.

Go to step 2.
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Action Yes No

Step 2
a From the printer software, set Collate to (1,2,3) (1,2,3).

Note: Setting Collate to (1,1,1) (2,2,2) in the software overrides
the setting in the Finishing menu.

b Resend the print job.

Did the job print and collate correctly?

The problem is
solved.

Go to step 3.

Step 3

Reduce the complexity of the print job by eliminating the number
and size of fonts, the number and complexity of images, and the
number of pages in the job.

Did the job print and collate correctly?

The problem is
solved.

Contact technical
support.

Unexpected page breaks occur

Action Yes No

Step 1

Adjust the print timeout settings.

a From the printer control panel, navigate to:

Settings > General Settings > Timeouts > Print Timeout
b Select a higher setting and then, depending on your printer

model, select  or Submit.
c Resend the print job.

Did the file print correctly?

The problem is
solved.

Go to step 2.

Step 2
a Check the original file for manual page breaks.

b Resend the print job.

Did the file print correctly?

The problem is
solved.

Contact technical
support.

Print quality problems

Characters have jagged or uneven edges
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Action Yes No

Step 1
a Print a font sample list to check if the fonts you are using are

supported by the printer.

1 From the control panel, navigate to:

Menus > Reports > Print Fonts
2 Select PCL Fonts or PostScript Fonts.

b Resend the print job.

Are you using fonts that are supported by the printer?

Go to step 2. Select a font that is
supported by the
printer.

Step 2

Check if the fonts installed on the computer are supported by the
printer.

Are the fonts installed on the computer supported by the printer?

The problem is
solved.

Contact technical
support.

Printer is printing blank pages

Action Yes No

Step 1
a Check if there is packing material left on the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Check if the packing material is properly removed from the
imaging unit.

Warning—Potential Damage: Do not expose the imaging
unit to direct light for more than 10 minutes. Extended
exposure to light may cause print quality problems.

3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.

Is the printer still printing blank pages?

Go to step 2. The problem is
solved.
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Action Yes No

Step 2
a Redistribute the toner in the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Firmly shake the imaging unit.

Warning—Potential Damage: Do not expose the imaging
unit to direct light for more than 10 minutes. Extended
exposure to light may cause print quality problems.

3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.

Is the printer still printing blank pages?

Go to step 3. The problem is
solved.

Step 3

Replace the imaging unit, and then resend the print job.

Is the printer still printing blank pages?

Contact technical
support.

The problem is
solved.

Clipped pages or images

Action Yes No

Step 1
a Move the width and length guides in the tray to the correct

positions for the paper loaded.

b Resend the print job.

Is the page or image clipped?

Go to step 2. The problem is
solved.

Step 2

From the printer control panel, set the paper size and type in the
Paper menu to match the paper loaded in the tray.

Do the paper size and type match the paper loaded in the tray?

Go to step 3. Do one or more of
the following:

• Specify the paper
size from the tray
settings to match
the paper loaded
in the tray.

• Change the
paper loaded in
the tray to match
the paper size
specified in the
tray settings.
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Action Yes No

Step 3
a Depending on your operating system, specify the paper size

from Printing Preferences or from the Print dialog.

b Resend the print job.

Is the page or image clipped?

Go to step 4. The problem is
solved.

Step 4
a Reinstall the imaging unit.

1 Remove the toner cartridge.

2 Remove the imaging unit.

Warning—Potential Damage: Do not expose the imaging
unit to direct light for more than 10 minutes. Extended
exposure to light may cause print quality problems.

3 Install the imaging unit, and then the cartridge.

b Resend the print job.

Is the page or image clipped?

Contact technical
support.

The problem is
solved.

Shadow images appear on prints

Action Yes No

Step 1

Load paper with the correct paper type and weight in the tray.

Is paper with the correct paper type and weight loaded in the tray?

Go to step 2. Load paper with the
correct paper type
and weight in the
tray.

Step 2

From the printer control panel, set the paper type and weight in
the Paper menu to match the paper loaded in the tray.

Is the tray set to the type and weight of the paper loaded?

Go to step 3. Change the paper
loaded in the tray to
match the paper type
and weight specified
in the tray settings.

Step 3
a Depending on your operating system, specify the paper type

and weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Do shadow images still appear on prints?

Go to step 4. The problem is
solved.
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Action Yes No

Step 4

Replace the imaging unit, and then resend the print job.

Do shadow images still appear on prints?

Contact technical
support.

The problem is
solved.

Gray background on prints

Action Yes No

Step 1
a From the Quality Menu on the printer control panel, decrease

the toner darkness.

Note: 8 is the factory default setting.

b Resend the print job.

Did the gray background disappear from the prints?

The problem is
solved.

Go to step 2.

Step 2

Reinstall the imaging unit and the toner cartridge.

a Remove the toner cartridge.

b Remove the imaging unit.

Warning—Potential Damage: Do not expose the imaging unit
to direct light for more than 10 minutes. Extended exposure
to light can cause print quality problems.

c Install the imaging unit, and then the cartridge.

d Resend the print job.

Did the gray background disappear from the prints?

The problem is
solved.

Go to step 3.

Step 3

Replace the imaging unit, and then resend the print job.

Did the gray background disappear from the prints?

The problem is
solved.

Contact technical
support.
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Incorrect margins on prints

Action Yes No

Step 1
a Move the width and length guides in the tray to the correct

positions for the paper size loaded.

b Resend the print job.

Are the margins correct?

The problem is
solved.

Go to step 2.

Step 2

From the printer control panel, set the paper size in the Paper menu
to match the paper loaded in the tray.

Does the paper size match the paper loaded in the tray?

Go to step 3. Do one or more of
the following:

• Specify the paper
size from the tray
settings to match
the paper loaded
in the tray.

• Change the
paper loaded in
the tray to match
the paper size
specified in the
tray settings.

Step 3
a Depending on your operating system, specify the paper size

from Printing Preferences or from the Print dialog.

b Resend the print job.

Are the margins correct?

The problem is
solved.

Contact technical
support.
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Paper curl

Action Yes No

Step 1

Move the width and length guides in the tray to the correct
positions for the size of the paper loaded.

Are the width and length guides positioned correctly?

Go to step 2. Adjust the width and
length guides.

Step 2

From the printer control panel, set the paper type and weight in
the Paper menu to match the paper loaded in the tray.

Do the paper type and weight match the type and weight of the
paper in the tray?

Go to step 3. Specify the paper
type and weight from
the tray settings to
match the paper
loaded in the tray.

Step 3
a Depending on your operating system, specify the paper type

and weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Is the paper still curled?

Go to step 4. The problem is
solved.

Step 4
a Remove the paper from the tray, and then turn it over.

b Resend the print job.

Is the paper still curled?

Go to step 5. The problem is
solved.

Step 5
a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store
paper in its original wrapper until you use it.

b Resend the print job.

Is the paper still curled?

Contact technical
support.

The problem is
solved.

Print irregularities
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Action Yes No

Step 1
a Move the width and length guides in the tray to the correct

positions for the size of the paper loaded in the tray.

b Resend the print job.

Do print irregularities still appear?

Go to step 2. The problem is
solved.

Step 2

From the printer control panel, set the paper size and type in the
Paper menu to match the paper loaded in the tray.

Do the printer settings match the type and weight of the paper
loaded in the tray?

Go to step 3. Specify the paper
size and type from
the tray settings to
match the paper
loaded in the tray.

Step 3
a Depending on your operating system, specify the paper type

and weight from Printing Preferences or from the Print dialog.

b Resend the print job.

Do print irregularities still appear?

Go to step 4. The problem is
solved.

Step 4

Check if the paper loaded in the tray has texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel, set the
paper texture in the
Paper menu to match
the paper loaded in
the tray.

Go to step 5.

Step 5
a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store
paper in its original wrapper until you use it.

b Resend the print job.

Do print irregularities still appear?

Go to step 6. The problem is
solved.

Step 6

Replace the imaging unit, and then resend the print job.

Do print irregularities still appear?

Contact technical
support or your Dell
printer dealer.

The problem is
solved.
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Repeating defects appear on prints

Action Yes No

Step 1

Measure the distance between the defects.
Check for a distance between the defects that equals:

• 97 mm (3.82 in.)

• 47 mm (1.85 in.)

• 38 mm (1.5 in.)

Is the distance between defects equal to one of the listed
measurements?

Go to step 2. 1 Check if the
distance
between the
defects equal to
80 mm (3.15 in.)

2 Take note of the
distance, and
then contact
technical
support or your
Dell printer
dealer.

Step 2

Replace the imaging unit, and then resend the print job.

Do the repeating defects still appear?

Contact technical
support or your Dell
printer dealer.

The problem is
solved.

Print is too dark

Action Yes No

Step 1
a From the Quality menu on the printer control panel, reduce the

toner darkness.

Note: 8 is the factory default setting.

b Resend the print job.

Is the print still too dark?

Go to step 2. The problem is
solved.
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Action Yes No

Step 2
a From the printer control panel, set the paper type, texture and

weight in the Paper menu to match the paper loaded in the tray.

b Resend the print job.

Is the tray set to the type, texture, and weight of the paper loaded?

Go to step 3. Do one or more of
the following:

• Specify the paper
type, texture, and
weight from the
tray settings to
match the paper
loaded in the tray.

• Change the
paper loaded in
the tray to match
the paper type,
texture and
weight specified
in the tray
settings.

Step 3
a Depending on your operating system, specify the paper type,

texture and weight from Printing Preferences or from the Print
dialog.

b Resend the print job.

Is the print still too dark?

Go to step 4. The problem is
solved.

Step 4

Check if the paper loaded in the tray has texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel,
change the texture
settings in the Paper
Texture menu to
match the paper you
are printing on.

Go to step 5.

Step 5
a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store
paper in its original wrapper until you use it.

b Resend the print job.

Is the print still too dark?

Go to step 6. The problem is
solved.

Step 6

Replace the imaging unit, and then resend the print job.

Is the print still too dark?

Contact technical
support.

The problem is
solved.
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Print is too light

Action Yes No

Step 1
a From the Quality menu on the printer control panel, increase

the toner darkness.

Note: 8 is the factory default setting.

b Resend the print job.

Is the print still too light?

Go to step 2. The problem is
solved.

Step 2

From the printer control panel, set the paper type, texture, and
weight in the Paper menu to match the paper loaded in the tray.

Is the tray set to the type, texture, and weight of the paper loaded?

Go to step 3. Change the paper
type, texture, and
weight to match the
paper loaded in the
tray.

Step 3
a Depending on your operating system, specify the paper type,

texture, and weight from Printing Preferences or from the Print
dialog.

b Resend the print job.

Is the print still too light?

Go to step 4. The problem is
solved.

Step 4

Make sure that the paper has no texture or rough finishes.

Are you printing on textured or rough paper?

From the printer
control panel,
change the texture
settings in the Paper
Texture menu to
match the paper you
are printing on.

Go to step 5.

Step 5
a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store
paper in its original wrapper until you use it.

b Resend the print job.

Is the print still too light?

Go to step 6. The problem is
solved.
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Action Yes No

Step 6
a Redistribute the toner in the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Firmly shake the imaging unit.

Warning—Potential Damage: Do not expose the imaging
unit to direct light for more than 10 minutes. Extended
exposure to light may cause print quality problems.

3 Install the imaging unit, and then the cartridge.

b Resend the print job.

Is the print still too light?

Go to step 7. The problem is
solved.

Step 7

Replace the imaging unit, and then resend the print job.

Is the print still too light?

Contact technical
support.

The problem is
solved.

Skewed print

Action Yes No

Step 1
a Move the width and length guides in the tray to the correct

positions for the size of the paper loaded.

b Resend the print job.

Is the print still skewed?

Go to step 2. The problem is
solved.

Step 2
a Check if you are printing on a paper that is supported by the

tray.

b Resend the print job.

Is the print still skewed?

Contact technical
support.

The problem is
solved.
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Printer is printing solid black pages

Action Yes No

Step 1
a Reinstall the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

Warning—Potential Damage: Do not expose the imaging
unit to direct light for more than 10 minutes. Extended
exposure to light may cause print quality problems.

2 Install the imaging unit, and then the cartridge.

b Resend the print job.

Is the printer printing solid black pages?

Go to step 2. The problem is
solved.

Step 2

Replace the imaging unit, and then resend the print job.

Is the printer printing solid black pages?

Contact technical
support.

The problem is
solved.

Transparency print quality is poor

Action Yes No

Step 1

From the printer control panel, set the paper type in the Paper
menu to match the paper loaded in the tray.

Is the paper type for the tray set to Transparency?

Go to step 2. Set the paper type to
Transparency.

Step 2
a Check if you are using a recommended type of transparency.

b Resend the print job.

Is the print quality still poor?

Contact technical
support.

The problem is
solved.
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Streaked horizontal lines appear on prints

Action Yes No

Step 1
a Depending on your operating system, specify the tray or feeder

from Printing Preferences or the Print dialog.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Go to step 2. The problem is
solved.

Step 2

From the printer control panel, set the paper type and weight in
the Paper menu to match the paper loaded in the tray.

Do the paper type and weight match the type and weight of the
paper in the tray?

Go to step 3. Change the paper
type and weight to
match the paper
loaded in the tray.

Step 3
a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store
paper in its original wrapper until you use it.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Go to step 4. The problem is
solved.

Step 4
a Reinstall the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

Warning—Potential Damage: Do not expose the imaging
unit to direct light for more than 10 minutes. Extended
exposure to light may cause print quality problems.

2 Install the imaging unit, and then the cartridge.

b Resend the print job.

Do streaked horizontal lines appear on prints?

Go to step 5. The problem is
solved.

Step 5

Replace the imaging unit, and then resend the print job.

Do streaked horizontal lines appear on prints?

Contact technical
support.

The problem is
solved.
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Streaked vertical lines appear on prints

Action Yes No

Step 1
a Depending on your operating system, specify the paper type,

texture, and weight from Printing Preferences or from the Print
dialog.

b Resend the print job.

Do streaked vertical lines appear on prints?

Go to step 2. The problem is
solved.

Step 2

From the printer control panel, set the paper texture, type, and
weight in the Paper menu to match the paper loaded in the tray.

Do the paper texture, type, and weight match the paper in the tray?

Go to step 3. Do one or more of
the following:

• Specify the paper
texture, type, and
weight from the
tray settings to
match the paper
loaded in the tray.

• Change the
paper loaded in
the tray to match
the paper
texture, type, and
weight specified
in the tray
settings.

Step 3
a Load paper from a fresh package.

Note: Paper absorbs moisture due to high humidity. Store
paper in its original wrapper until you use it.

b Resend the print job.

Do streaked vertical lines appear on prints?

Go to step 4. The problem is
solved.
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Action Yes No

Step 4
a Reinstall the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

Warning—Potential Damage: Do not expose the imaging
unit to direct light for more than 10 minutes. Extended
exposure to light may cause print quality problems.

2 Install the imaging unit, and then the cartridge.

b Resend the print job.

Do streaked vertical lines appear on prints?

Go to step 5. The problem is
solved.

Step 5

Replace the imaging unit, and then resend the print job.

Do streaked vertical lines appear on prints?

Contact technical
support or your Dell
printer dealer.

The problem is
solved.

Horizontal voids appear on prints

Action Yes No

Step 1
a Make sure your software program is using a correct fill pattern.

b Resend the print job.

Do horizontal voids appear on prints?

Go to step 2. The problem is
solved.

Step 2
a Load the specified tray or feeder with a recommended type of

paper.

b Resend the print job.

Do horizontal voids appear on prints?

Go to step 3. The problem is
solved.
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Action Yes No

Step 3
a Redistribute the toner in the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Firmly shake the imaging unit.

Warning—Potential Damage: Do not expose the imaging
unit to direct light for more than 10 minutes. Extended
exposure to light may cause print quality problems.

3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.

Do horizontal voids appear on prints?

Go to step 4. The problem is
solved.

Step 4

Replace the imaging unit, and then resend the print job.

Do horizontal voids appear on prints?

Contact technical
support.

The problem is
solved.

Vertical voids appear on prints

Action Yes No

Step 1
a Make sure your software program is using a correct fill pattern.

b Resend the print job.

Do vertical voids appear on prints?

Go to step 2. The problem is
solved.

Step 2
a From the printer control panel, set the paper type and weight

in the Paper menu to match the paper loaded in the tray.

b Resend the print job.

Do vertical voids appear on prints?

Go to step 3. The problem is
solved.
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Action Yes No

Step 3

Check if you are using a recommended type of paper.

a Load the indicated tray or feeder with a recommended type of
paper.

b Resend the print job.

Do vertical voids appear on prints?

Go to step 4. The problem is
solved.

Step 4
a Redistribute the toner in the imaging unit.

1 Remove the toner cartridge, and then the imaging unit.

2 Firmly shake the imaging unit.

Warning—Potential Damage: Do not expose the imaging
unit to direct light for more than 10 minutes. Extended
exposure to light may cause print quality problems.

3 Reinstall the imaging unit, and then the cartridge.

b Resend the print job.

Do vertical voids appear on prints?

Contact technical
support.

Note: The laser
scanning unit may
be defective.

The problem is
solved.

Toner specks appear on prints

Action Yes No

Replace the imaging unit, and then resend the print job.

Do toner specks appear on prints?

Contact technical
support.

The problem is
solved.

Uneven print density

Action Yes No

Replace the imaging unit, and then resend the print job.

Is the print density uneven?

Contact technical
support.

The problem is
solved.
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Embedded Web Server does not open
Action Yes No

Step 1
a Turn on the printer.

b Open a Web browser, and then type the printer IP address.

c Press Enter.

Does the Embedded Web Server open?

The problem is
solved.

Go to step 2.

Step 2

Make sure the printer IP address is correct.

a View the printer IP address:

• From the TCP/IP section in the Network/Ports menu

• By printing a network setup page or menu settings page,
and then finding the TCP/IP section

Note: An IP address appears as four sets of numbers
separated by periods, such as 123.123.123.123.

b Open a Web browser, and then type the IP address.

Note: Depending on the network settings, you may need to
type “https://” instead of “http://” before the printer IP
address to access the Embedded Web Server.

c Press Enter.

Does the Embedded Web Server open?

The problem is
solved.

Go to step 3.

Step 3

Check if the network is working.

a Print a network setup page.

b Check the first section of the network setup page and confirm
that the status is Connected.

Note: If the status is Not Connected, then the connection
may be intermittent, or the network cable may be defective.
Contact your system support person for a solution, and then
print another network setup page.

c Open a Web browser, and then type the printer IP address.

d Press Enter.

Does the Embedded Web Server open?

The problem is
solved.

Go to step 4.
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Action Yes No

Step 4

Check if the cable connections to the printer and print server are
secure.

a Connect the cables properly. For more information, see the
setup documentation that came with the printer.

b Open a Web browser, and then type the printer IP address.

c Press Enter.

Does the Embedded Web Server open?

The problem is
solved.

Go to step 5.

Step 5

Temporarily disable the Web proxy servers.
Proxy servers may block or restrict you from accessing certain
Web sites including the Embedded Web Server.

Does the Embedded Web Server open?

The problem is
solved.

Contact your system
support person.

Contacting technical support
When you call technical support, describe the problem, the message on the printer display, and the
troubleshooting steps you have already taken.

See the label inside the top front cover or at the back of the printer, and then take note of the following:

• The printer model

• The service tag number or express service code

For more information, go to www.dell.com/support.

Troubleshooting 145

http://www.dell.com/support


Appendix

Dell Technical Support Policy
Technician‑assisted technical support requires the cooperation and participation of the customer in the
troubleshooting process and provides for restoration of the Operating System, application software and
hardware drivers to the original default configuration as shipped from Dell, as well as the verification of
appropriate functionality of the printer and all Dell‑installed hardware. In addition to this technician assisted
technical support, online technical support is available at Dell Support. Additional technical support options
may be available for purchase.

Dell provides limited technical support for the printer and any Dell‑installed software and peripherals. Support
for third‑party software and peripherals is provided by the original manufacturer, including those purchased
and/or installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory Integration
(CFI/DellPlus).

Contacting Dell
You can contact Dell electronically using the following address: www.dell.com/contactdell.

Product power consumption
The following table documents the power consumption characteristics of the product.

Note: Some modes may not apply to your product.

Mode Description Power consumption
(Watts)

Printing The product is generating hard‑copy output from electronic inputs. 560 (one-sided), 380 (two-
sided)

Copy The product is generating hard‑copy output from hard‑copy original
documents.

NA

Scan The product is scanning hard‑copy documents. NA

Ready The product is waiting for a print job. 8

Sleep Mode The product is in a high‑level energy‑saving mode. 3

Hibernate The product is in a low‑level energy‑saving mode. 0.5

Off The product is plugged into an electrical outlet, but the power switch is
turned off.

0.0

The power consumption levels listed in the previous table represent time-averaged measurements.
Instantaneous power draws may be substantially higher than the average.
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Sleep Mode
This product is designed with an energy-saving mode called Sleep Mode. The Sleep Mode saves energy by
lowering power consumption during extended periods of inactivity. The Sleep Mode is automatically engaged
after this product is not used for a specified period of time, called the Sleep Mode Timeout.

Factory default Sleep Mode Timeout for this product (in minutes): 20

By using the configuration menus, the Sleep Mode Timeout can be modified between 1 minute and 120 minutes.
Setting the Sleep Mode Timeout to a low value reduces energy consumption, but may increase the response
time of the product. Setting the Sleep Mode Timeout to a high value maintains a fast response, but uses more
energy.

Hibernate Mode
This product is designed with an ultra‑low power operating mode called Hibernate mode. When operating in
Hibernate Mode, all other systems and devices are powered down safely.

The Hibernate mode can be entered in any of the following methods:

• Using the Hibernate Timeout

• Using the Schedule Power modes

• Using the Sleep/Hibernate button

Factory default Hibernate Timeout for this product in all countries or regions 3 days

The amount of time the printer waits after a job is printed before it enters Hibernate mode can be modified
between one hour and one month.

Off mode
If this product has an off mode which still consumes a small amount of power, then to completely stop product
power consumption, disconnect the power supply cord from the electrical outlet.

Total energy usage
It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are
provided in power units of Watts, the power consumption should be multiplied by the time the product spends
in each mode in order to calculate energy usage. The total product energy usage is the sum of each mode's
energy usage.

Warranty and Return Policy
Dell Inc. (“Dell”) manufactures its hardware products from parts and components that are new or equivalent to
new in accordance with industry‑standard practices. For information about the Dell warranty for your printer,
refer to the Product Information Guide.
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